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QuickTime 3 Pro: MoviePlayer for Windows 95/NT 4

Overview

This page provides an index to the Windows MoviePlayer 3 Primer. The documents are geared for the novice
user as well as anyone who wants to learn more about the many features that make MoviePlayer so much more
than just a player of QuickTime movies. There are nearly 100 pages of documentation here.This Primer was
written by Judy Stern and Robert Lettieri, producers of Judy and Robert’s Little QuickTime Page.

Find Out More

Chapter 1: Introduction: Answers some basic questions about QuickTime and MoviePlayer. 

Chapter 2: Understanding QuickTime as a Multimedia Container: Explains the types of QuickTime movies as
well as what types of tracks can be used within QuickTime. 

Chapter 3: Movie Playing: Covers, in detail, the various methods for viewing movies. 

Chapter 4: Movie Editing Basics: Covers the basics of editing with MoviePlayer. 

Chapter 5: Translating To and From QuickTime : Covers how to create QuickTime tracks from non-QuickTime
media files and how to change QuickTime tracks to other file formats or other QuickTime track types. 

Chapter 6: Track Editing: Explains how to merge tracks and how to alter them independently.

Appendix: Covers information about QuickTime capabilities which are available to MoviePlayer as well as
other software applications. 

Get QuickTime Pro

http://www.bmug.org/quicktime/
http://www.apple.com/quicktime/
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Chapter 1: Introduction

Welcome to QuickTime and MoviePlayer.

QuickTime is system software that gives your computer exciting multimedia capabilities.

MoviePlayer is an application that comes with QuickTime and provides direct and easy access to many of those
multimedia capabilities.

This document introduces you to the capabilities of QuickTime by showing you some of the basics of
MoviePlayer. We begin by answering some basic questions.

• What Is QuickTime? 

• What Is MoviePlayer? 

• What’s a QuickTime Movie?
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WHAT IS QUICKTIME?

QuickTime—introduced by Apple Computer in 1991—was the first technology that enabled personal computers
to work with synchronized time-based data, or data that changes over time, such as video. QuickTime was first
to make digital video accessible to ordinary computer users, because video creation and playback was both easy
and inexpensive. The most significant thing about QuickTime, from a cost standpoint, was that QuickTime
movies could be played on computers without special hardware.

QuickTime continues to be the leader in the digital video world. QuickTime has grown from its humble
beginnings as “postage-stamp-sized” video to today’s nearly full-frame and full-motion video, always taking
advantage of state-of-the-art compression technologies. Early on it extended beyond the Macintosh world, so
that QuickTime movies could be played back on most Windows-based computers, as well as Mac OS-based
computers, making it ideal for both CD-ROM and Internet publishing.

However, from the beginning, QuickTime was more than just a video technology; it was designed to be a
container for many kinds of media. Early QuickTime movies held synchronized video and audio. Over the
years, other media types have been included in QuickTime—text, music, animated sprites, and 3D animations—
all of which can be synchronized with each other in a single movie. Additionally, QuickTime has been extended
to include QuickTime VR, “virtual reality” technology that lets users explore spaces and interact with objects.

Although it has been possible to play back QuickTime movies on Windows computers for a number of years,
QuickTime 3 is the first release to give Windows computers the same full range of multimedia capabilities
available on Macintosh for years. QuickTime now transcends operating systems.

It’s important to understand that QuickTime isn’t an application program. It’s an enabling technology that
provides functionality that application programs can use. Its multimedia capabilities are used by hundreds of
programs on both platforms. QuickTime looks and acts the same way in almost every program that supports it.
You can copy video data between many of these programs as easily as you move text between other programs.

MoviePlayer is just one of many applications that provide access to QuickTime. It’s a simple but powerful tool
that showcases QuickTime’s many capabilities

WHAT IS MOVIEPLAYER?

MoviePlayer is designed to exploit QuickTime. And because QuickTime does more than any other multimedia
architecture, MoviePlayer does more than any other “player” you’ll find on any platform.

MoviePlayer’s name is a bit misleading: this powerful tool handles more than just video movies, and it can be
used for much more than playing movies.

MoviePlayer can handle all the QuickTime media types. It can open and play any QuickTime movie, no matter
what kind of data that movie contains. It also allows you to import a vast number of different media files,
including almost all the audio, animation, and graphic formats available on Windows and Mac OS computers
and on the Internet.

If you register QuickTime, you can also use MoviePlayer to edit and combine all these media types to form a
large variety of multimedia files for a large variety of uses—from business to entertainment to education—for
use on a large variety of platforms—including the Internet and CD-ROM, as well as for video production.

There’s a lot more to be said, but if you really want to understand what QuickTime and MoviePlayer can do,
you need to start working with the software.
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If you haven’t already downloaded and installed the latest versions of QuickTime and MoviePlayer, you can get
them at the QuickTime Web site (http://www.apple.com/quicktime/). The software you download is the
Standard Edition. You can upgrade to the Pro Edition (which provides access to all the features with the Pro
icon in this document) by registering your software. You are given the option of registering the first time you
open MoviePlayer; you can also register at any later time (see “Registration” section in the appendix).

WHAT’S A QUICKTIME MOVIE?

A QuickTime movie is a file that contains data—visual and/or aural—that you can play or manipulate.

If you’ve never done so, you should open and play a movie. In the folder called QuickTime (which was
installed when you installed QuickTime), you’ll find a sample movie file, Sample.mov.

There are three ways to open a movie file in MoviePlayer:

• Double-click the file’s icon. (This will only work if the movie has a .mov extension.)

• Drag the movie onto the MoviePlayer application icon.

• Open MoviePlayer first, then open the file from within MoviePlayer by choosing Open from the File
menu.

Once a movie is open, you see a window with a filename at the top, and a control bar with various buttons at the
bottom.

You can click the right-pointing triangle in the bottom-left corner of the window to play the movie. You should
hear audio and see a moving image.

A movie playing in MoviePlayer

http://www.apple.com/quicktime/
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We’ll explain the other buttons on the control bar in later chapters where you’ll discover how you can use
MoviePlayer and QuickTime to play and edit your own multimedia creations.

As long as you’ve played at least one movie, you’re ready to move on to the next chapter, where you’ll begin to
understand that there’s no simple answer to the question “What’s a QuickTime movie?”—the multimedia
possibilities are endless!
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Chapter 2: Understanding QuickTime as a Multimedia Container

Although the majority of QuickTime movies have only a visual and an audio component, QuickTime has a rich
set of multimedia capabilities that may not be immediately apparent.

In this chapter, we’ll introduce you to the different types of QuickTime movies, as well as covering QuickTime
tracks, the basic elements from which QuickTime movies are composed.

• Types of QuickTime Movies 

• Standard QuickTime movies 

• QuickTime VR movies 

• QuickTime Track Types 

• Video 

• Sound

• Music

• Text

• 3D 

• Sprite 

• Tracks associated with QuickTime VR 

• Other tracks

• Getting Information About a QuickTime Movie 

• Finding out what tracks are in a movie 

• Getting general information about the movie and its tracks 

• Finding out the duration and dimensions of a movie 

• Getting information about the format of video and sound tracks 

• Determining the frame rate of a video track 

• Finding out what instruments are used in a music track 

• Data not contained in a track: Annotations 
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TYPES OF QUICKTIME MOVIES

Currently QuickTime has two basic movie types: the standard time-based movie and the QuickTime VR movie.
Time-based movies occur over time, and have a beginning, middle, and end. QuickTime VR movies provide an
immersive experience, allowing viewers to move through space rather than time; this type of movie is often
called desktop virtual reality.

Standard QuickTime movies (time-based)

The most common type of QuickTime movie contains a visual and an audio component. When you open the
movie, it looks something like this:

A movie with video and audio

The buttons and controls at the bottom of the window allow you to manipulate the movie. (We cover these in
Chapter 3, Movie Playing.)

The types of media data used for the visual and audio components may vary. The visual component can hold
digital video, text, sprite animation, and 3D animation, each of which has advantages for particular applications.
The audio component can hold either digitized sound or MIDI music. (For more on these data types, see
QuickTime Track Types, later in this chapter. )

Also, some movies may not even look like the one above, since different media types can be combined in a
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large variety of ways, or a single media type can stand alone.

Some examples of different kinds of movies include:

• a movie that has video, audio, and text

• a movie that has only audio (digitized sound and/or MIDI music)

• a movie that has text with audio (such as spoken word)
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• a movie that has two video tracks side by side

Many other kinds of movies are possible.

QuickTime VR movies (spatial movies)

There are two basic types of QuickTime VR movies: panoramic movies and object movies. Panoramic movies
give you the experience of being in the center of a space and looking around, whereas object movies generally
give you the experience of looking at and rotating an object.
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QuickTime VR panoramic movie

QuickTime VR object movie
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You can manipulate VR movies by dragging across the image, but you can also use buttons located at the
bottom of the window.

It’s possible to have a single file containing multiple panoramas and/or object movies; to move between each
movie (called a node), you click predefined areas (called hot spots) within the movies. Hot spots can also be
used to trigger other events, such as telling a Web browser to download a Web page.

Although you can use MoviePlayer to view QuickTime VR movies, including jumping from node to node, you
can’t use it to combine QuickTime VR movies or define hot spots.

QUICKTIME TRACK TYPES

QuickTime stores different types of data separately in tracks. Because they are separate elements, you can
manipulate the tracks individually, even though they stay synchronized during playback. Using tools like
MoviePlayer, you can edit tracks, move them from one movie to another, turn them on and off, or get rid of
them. (We cover these techniques in Chapter 6, Track Editing.)

Here’s a brief review of the current QuickTime track types.

Video track

A video track is the standard track for holding visual data in QuickTime movies. A video track can hold
digitized video or computer-generated images, or both. (QuickTime supports many video, animation, and still
image formats. Some of these include AVI, DV, Animated GIF, FLI/FLC, BMP, JPEG, and PICT; see the
appendix for a complete list.) A video track is composed of a number of sequential images, with each image
composed of pixels, or individual squares of color. There are other track types that hold visual data but these are
not composed entirely of pixels.

To work with video tracks, you should understand two fundamental concepts: frame rate and compression.

The frame rate is the number of individual images shown every second. While standard U.S. video has a frame
rate of about 30 frames per second (fps), QuickTime movies can have more or fewer than 30 frames per second.
Typically, there are fewer frames because movies with a high frame rate often can’t be played back on
computers that transfer data relatively slowly. For example, the video tracks of QuickTime movies made for
CD-ROMs or the Internet typically have frame rates of 10 to 20 frames per second. For these movies, the video
track is one-third to two-thirds the size that it would have been at 30 frames per second.

Compression is crucial to the video track, particularly for movies with a high frame rate. An individual full-
screen image is about 1 MB in size, which means that 30 fps, full-screen video would contain close to 30 MB of
information per second of video. And that doesn’t even include the audio! That’s too much information to store
and too much information for a computer without special hardware to move onto your screen quickly enough.
And it’s way too much information to move over a modem, which typically has speeds of far less than 1 MB per
second. Even if you use only a portion of the screen and lower the frame rate, as with many QuickTime movies,
without compression it’s still too much information.

Essentially, compression is a method of cheating: although you may be seeing what looks like many megabytes
of information per second, the data that’s actually been stored and shown is much less, due to various
techniques for reducing the amount of data necessary to display images. QuickTime provides access to a wide
variety of compressors, each of which works slightly differently and is appropriate for different types of media.
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(See section on “Exporting as a QuickTime movie” in Chapter 5 to find out how you can access QuickTime’s
compression features using MoviePlayer. See the appendix, for a description of each of the compressors.)

Sound track

A sound track is the standard track for holding digitized audio. There are many digital sound formats;
QuickTime supports all of the most common, including AIFF, WAV, Sound Designer 2, and AU.

The properties that define a sound track are the sample rate (the number of sound samples per second), the
sample size (the number of bits available to represent each sound sample), and the number of channels —two
(stereo) or one (mono). Often, compression is applied to audio tracks as well. These options are discussed in
greater detail in “Exporting a sound track” in Chapter 5 and the appendix.

Music track

Another kind of audio track is a music track, which is based on MIDI (Musical Instrument Digital Interface), a
standard in the electronic music industry.

Unlike a QuickTime sound track, the music track stores data as a sequence of commands that tell the system
what notes to play, how to play them, and how long to play them. It relies on a music synthesizer to actually
play those notes. Most computers, with the help of QuickTime, will do the job of a synthesizer. (With the right
software and hardware, the commands can also be sent to an internal or external hardware synthesizer, resulting
in improved audio quality.)

The storage space taken by the data in a music track is very small compared to digitized sound.

Text track

The text track holds only text. Since tracks in a movie are synchronized, it provides a way to caption a movie or
index it. The data for a text track is stored as text (i.e. not as a graphic), so it takes up only a small amount of
disk storage space. Text tracks are also searchable; viewers can search for key words to find precise points in
the movie.

It’s easy to create a text track using only MoviePlayer and a simple text editor or word processor. (See “Creating
a text track from a text file” in Chapter 5, and “Adding text” in Chapter 6.)

3D track

The QuickTime 3D track holds 3D data, which includes geometric definitions of objects, as well as descriptions
of the objects’ surfaces (including texture and lighting). This data can be defined in a 3D application and then
converted to a QuickTime 3D track.

A 3D track works in conjunction with another track, the tween track, which defines the motion of the object
(whether it spins, moves across a space, etc.).

It is possible to convert a 3D animation to a standard QuickTime video track. However, this means converting
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all the data that defines a 3D object and its movement into pixels, with a separate frame for each position of the
object. The amount of data required for all those pixels and all those frames, even with compression, is much
greater than the amount of data required to define an object and its motion. A 3D track yields a much smaller
file size, and potentially smoother performance.

In addition, the behavior of objects in a video track is fixed, whereas an object in a 3D track can be programmed
to behave differently or appear differently depending on user input.

Sprite track

The sprite track contains graphic objects (called sprites) that can be moved and resized independently.

Like a video track, a sprite track has a sequence of frames and a frame rate. But, unlike a video track in which
the information is entirely pixel-based, each sprite is stored only once in a movie file and its movement is
specified separately. Because the sprite gets reused in each frame, there is no need to store individual frames full
of pixels. Thus, sprite tracks are much smaller in file size than video tracks.

Tracks associated with QuickTime VR

All QuickTime VR movies contain at least one QuickTime video track. Additional video tracks are present
when movies have multiple nodes, hot spots, or other special features. QuickTime VR panoramic movies also
contain a VR Panorama track.

Movies created with newer versions of QuickTime VR (QuickTime VR 2.0 and later) contain a Quicktime VR
track. QuickTime VR 2.0 object movies contain a VR Object track.

Other tracks: timecode, tween, base

There are a few other track types that don’t correspond to specific media types such as sound, music, or
animation. These tracks serve a functional purpose. You can’t do much useful with them in MoviePlayer but
they may be useful with other applications that use QuickTime. You should also be aware of them so you’ll
recognize them if you see them. (See “Finding out which tracks are in a movie” later in this chapter.)

The timecode track is useful to professional video editors. The information in this track identifies each frame of
the movie using the timecode from the identical frame in the original source videotape. When this track is
visible, it typically appears in the bottom of the movie window and appears as hours:minutes:seconds:frames
(e.g. 00:06:19:11); as the movie plays the numbers increase accordingly.

Tween tracks and base tracks both serve to modify other tracks. These tracks contain information about what
some other track should or can do. The tween track is often used in conjunction with 3D tracks; the tween track
specifies the animation of the 3D object contained in the 3D track. Base track is the default name given to an
undefined or unnamed track.
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GETTING INFORMATION ABOUT A QUICKTIME MOVIE

As you start to explore QuickTime movies using MoviePlayer, you’ll want to use the movie info window, which
you open by choosing Get Info from the Movie menu. The movie info window is quite extensive, and has a
number of different panels. You’ll learn about some of these panels in this section, and many other panels in
other chapters of this document.

Finding out which tracks are in a movie

Because it’s not always obvious which tracks are contained in a movie, it’s useful to have a way to check this.
You can do so using the movie info window.

To find out which tracks are contained in a QuickTime movie:

1. Choose Get Info from the Movie menu.

Opening the movie info window

The info window for the movie appears.

2. Press the left pop-up menu (which currently says “Movie.”)
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Using the movie info window to see what tracks are contained in a movie

A list of the tracks in the movie appears. Depending on the movie you’re examining, you may see a single track,
such as a video track, or you may see more than one, as in the figure above.

Getting general information about the movie and its tracks

You can get basic information about the movie and its tracks using the movie info window’s General panels.

To get general information about the contents of your movie file:

1. If the movie info window isn’t already visible, open it by choosing Get Info from the Movie menu.

2. Make sure Movie is selected in the left pop-up menu, then choose General from the right pop-up menu.

General movie information
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The information that appears gives you a good overview of your entire movie.

Track Count tells you the total number of tracks in the movie.

Data Size tells you the combined size of all tracks in the movie. It is approximately the same as the file
size for the movie, assuming there are no file dependencies. (See “File dependencies” in Chapter 4 for
an explanation.)

Data Rate tells you the amount of data that needs to be played every second. It’s important to know the
data rate if your movie is intended to be played from a CD-ROM or over a network, since the data
transfer rate of a CD or network is particularly low.

To get general information about a specific track:

• In the movie info window, choose the track from the left pop-up menu and choose General from the
right pop-up menu.

General track information

The information that appears is similar to that in the General panel for the movie file, with the addition of some
time-related information.

Start Time tells you at what point in the movie this track starts.

Duration tells you the how long this track lasts.

Track Type tells you the track type. This is helpful if you change the name of the track using the
Change Name button.

Data Size tells you how much data is contained in this track.

Data Rate tells you how much data is contained in this track per second.

Change Name button allows you to change the track’s name. The nameappears in the left pop-up menu
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and by default is the track type. Changing the track name can be particularly useful if you have more
than one of a single track type.

Getting information about the duration and dimensions of a movie

The Size and Time panels provide additional information about the movie.

To find out how long the movie is:

1. If the movie info window isn’t already visible, open it by choosing Get Info from the Movie menu.

2. Choose Movie from the left pop-up menu and choose Time from the right pop-up menu.

The movie’s duration is shown in the second line.

Other information provided includes the point in time in the movie where the slider is currently located
(“Current Time”), and possibly information about the current selection. (The slider is covered in “The slider and
the play bar” in Chapter 3. The selection is covered in “Cut, Copy and Paste” in Chapter 4.)

Time values in the Time panel are represented as hours:minutes:seconds.thirtieths of a second.

To find out the dimensions of the image in the movie window:

• In the movie info window, make sure Movie is chosen in the left pop-up menu, then choose Size from
the right pop-up menu.
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Size info panel

The first line of information that appears tells you the dimensions of the movie at its normal size. (The word
“none” appears for movies with no visual track.)

The second line tells you the dimensions at which the movie window is currently set. It will only be different
from the first line if the window size has been altered. If the movie is at normal, half, or double size, this will be
indicated in parentheses. (See “Changing Window Sizes” in Chapter 3 for more information.)

The dimensions listed don’t include the height of the controller.

Getting information about the format of video and sound tracks

You can use the Format panel to get information about video and sound tracks.

To get format information about a specific video or sound track:

1. If the movie info window isn’t already visible, open it by choosing Get Info from the Movie menu.

2. Choose the track from the left pop-up menu and choose Format from the right pop-up menu.

There are four kinds of information provided for video tracks.

Width is the length (in pixels) from side to side of the image in this track.

Height is the length (in pixels) from top to bottom of the image in this track. It does not include the
height of the controller.

Colors is the number of colors that comprise the image in this track. This could be millions, millions +,
thousands, 256, 16, 4, or Black & White. (See the appendix for more information.)

Data Format tells you how the video data is stored. For some media file formats (e.g. QuickTime and
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AVI) the data is stored differently depending on the compressor used on the file; the data format listed is
the compressor. (See the section “Video track” earlier in this chapter, as well as the appendix for more
information about compression.) For other media file formats, the data format listed is identical to the
file type (e.g. GIF, BMP, Targa, etc.).

There are also four kinds of information provided for sound tracks.

Sample Rate is the number of sound samples per second.

Channels tells you whether the track is stereo or mono.

Sample Size is the number of bits available to represent each sound sample.

Compression tells if and how the sound was compressed.

(See appendix for more information on these four properties.)

Determining the frame rate of a video track

You can also use the movie info window to find out a video track’s frame rate.

To find out the frame rate of a video track:

1. If the movie info window isn’t already visible, open it by choosing Get Info from the Movie menu.

2. Choose the track from the left pop-up menu and choose Frame Rate from the right pop-up menu.

The Frame Rate panel shows two kinds of information concerning frame rates.

Movie FPS tells the average number of frames per second contained in the movie.

Playing FPS shows the frame rate “live” as the movie plays. This rate may be lower than the Movie
FPS if the computer on which the movie is played is not fast enough.

Finding out what instruments are used in a music track

Recall that the information stored in a music track is a series of commands telling QuickTime what notes to play
and how to play them. Part of this information includes the specific musical instruments to be synthesized in
playing the notes.

To see the list of instruments used in a music track:

1. If the movie info window isn’t already visible, open it by choosing Get Info from the Movie menu.

2. Choose the music track from the left pop-up menu, and choose Instruments from the right pop-up menu.

The information in the bottom of the window shows a list. The items in this list are the General MIDI
instruments currently used in the music track. (You can change the sound of a music track by assigning different
instruments; see “Changing instruments in music tracks” in Chapter 6.)
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Instrument panel showing instruments used in a music track

Data not contained in a track: Annotations

QuickTime movies may contain annotations that provide information about various properties of the movie. The
current list of properties includes Artist, Author, Comment, Copyright, Creation Date, Description, Director,
Disclaimer, Full Name, Host Computer, Information, Make Model, Original Format, Original Source,
Performers, Producer, Product, Software, Special Playback Requirements, Warning, Writer, and Edit Date.

You can view these properties using the Annotations panel.

To view annotations:

1. If the movie info window isn’t already visible, open it by choosing Get Info from the Movie menu.

2. Make sure Movie is selected in the left pop-up menu, then choose Annotations from the right pop-up menu.
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Annotations Panel

3. Select any line in the Properties list.

If data had been previously assigned to the selected property, it appears in the field below the list. (The steps for
adding and editing this data is covered in “Annotations” in Chapter 4.)

Some of this annotation data also appears in the Movie Information dialog box.

To see a subset of the annotation information for a movie:

• Choose Show Copyright from the Movie menu.

The Movie Information dialog box appears.
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Movie Information dialog box

The text corresponds to the data assigned to Copyright, Full Name, and Information in the Annotations panel.

Besides the textual data, this window often also has an image in the upper-left corner. This image is called the
poster. (See “Setting the Poster Frame” in Chapter 4 for information on setting a poster image.)
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Chapter 3: Movie Playing

In the first two chapters we quickly covered how to open and play a QuickTime movie and how to get basic
information about movies and the tracks in them. In this chapter, we’ll cover in detail all the methods available
for viewing movies.

• The Movie Controller: Basics 

• Playing and pausing 

• The slider and the play bar 

• Using the Step buttons to move one frame at a time 

• Changing the audio level 

• Chapter lists 

• Interacting With QuickTime VR Movies 

• Looking around in panoramic movies 

• Turning objects around in object movies 

• Finding and using hot spots 

• Zooming in and out 

• Moving zoomed-in objects 

• Changing Window Sizes 

• Menu options for resizing 

• Direct window manipulation 

• Presenting Movies 

• Presenting time-based movies 

• Presenting QuickTime VR movies 

• Other Movie Playing Options 

• Text Track Searching 

• Choosing a Language 

• Continuous and backwards play 

• Playing all the frames in a movie 

• Playing all open movies 

• Scratching 

• Jumping to the beginning or end 

• Muting the audio 

• Audio overdriving 

• Changing the controller 

• MoviePlayer Preferences 

• Movie Controls Summary 
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THE MOVIE CONTROLLER: BASICS

Whenever you open a standard time-based movie in MoviePlayer (as well as in many other applications), you
see the same control bar, or movie controller, at the bottom of the window. Let’s go over the basic components
of this controller.

The QuickTime movie controller

Playing and pausing

The triangle near the left side of the controller is called the Play button.

The Play button

To play a movie:

• Click the Play button.

When a movie is playing, the button changes to a Pause button, which has two parallel bars.

The Pause button

To pause a playing movie:

• Click the Pause button.

The movie stops playing, and the button changes back to the Play button.

If you see a Pause button, the movie is playing; if you see a Play button, the movie is paused.

Shortcuts:
Press the Enter key or Space bar to play a paused movie, or to pause a playing movie.
Double-click the movie image to play a movie.
Click a playing movie once to pause it.

The slider and the play bar

As a movie plays, a rectangle to the right of the Play button moves from left to right. That rectangle is called the
slider. It marks your place in time over the length of the movie. The area in which it moves is called the play
bar. (The slider is sometimes also called the play bar thumb.)
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The slider and play bar

To change the current viewing point in the movie:

• Drag the slider to the right or the left.

Dragging the slider

Dragging the slider causes the movie to move forward and backward, though without audio and not necessarily
at its normal rate.

Each time you move the slider, you change the current viewing point in the movie. Moving the slider all the
way to the left sets the movie to the beginning. Moving it all the way to the right sets the movie to the end.

When you click the Play button, the movie starts playing from the frame at which the slider is located. If the
slider is at the far left, the movie plays from the beginning. If the slider is in the middle, the movie starts playing
somewhere in the middle. If the slider is at the far right, the movie starts over from the beginning.

Using the Step buttons to move one frame at a time

To the right of the play bar are two buttons, called the Step buttons, each of which is marked with a vertical bar
and a triangle.

The Step buttons

Recall that some tracks (such as video and sprite) are composed of a series of individual images called frames.
If a movie contains a track composed of frames, the Step buttons jump the movie to the next or previous frame.

To jump to the next frame:

• Click the right Step button.

To jump to the previous frame:

• Click the left Step button.

Typically, each time you click a Step button, you see the image change only slightly, since each frame may
represent a fraction of a second of time.
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If a movie doesn’t have any tracks composed of frames, clicking the Step buttons has different results. For
example, if a movie has only a sound track or only a music track, the Step buttons advance the movie by a
quarter of a second. With 3D tracks, the Step buttons simply advance the movie all the way to the end, or return
it to the beginning.

Keyboard shortcuts: The Left and Right Arrow keys on the keyboard also step you through a movie one
frame at a time. The Left Arrow key moves you towards the front of the movie; the Right Arrow key
moves you towards the end.

Changing the audio level

To the left of the Play button is typically a Volume Control button, which looks like a little speaker.

The Volume Control button

You use this button to control the audio level of your movie. (If there is no Volume Control button, as in the
movie below, it means that the movie has no audio track.)

A movie without audio

To change the volume of a movie that has audio:
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1. Press the Volume Control button. An image that looks like a thermometer appears to the left of your pointer.
This is called the volume controller.

The volume controller

2. As you continue to press your mouse button, drag the slider on the volume controller up or down.

You’ll see that you are moving a slider similar to the slider that you move to control your place in a movie,
although this slider moves vertically in the volume controller. As you move the slider up and down, the number
and size of the lines emanating from the speaker change. When the slider is at the top, there are two lines
emanating from the speaker. When the slider is at the bottom, there are no lines emanating from the speaker;
this means that the sound is turned off or muted so you won’t hear it when the movie plays. Values in between
are indicated by one or two lines of varying sizes.

3. Release the mouse button when the slider is where you want it.

Keyboard shortcuts: You can also use the Up and Down Arrow keys to control the volume of the movie
(Up increases the volume, Down decreases it). If you press one of these keys enough times, the number
of lines emanating from the speaker icon changes (indicating the volume level has changed).

Chapter Lists

An additional control may appear in the movie controller. Instead of the play bar extending from the Play button
to the Step buttons, there’s a small text area just to the left of the Step buttons. This is the Chapter List button.

When you press the Chapter List button, a pop-up menu appears showing a list of chapters in the movie. You
can use this list to move quickly to specific points in a movie.
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Pop-up menu with chapter list

A chapter list is technically a text track associated with some other track in the movie. If you open the
movie info window (by choosing Get Info from the Movie menu) for a movie with chapter list, Chapters
appears in the right pop-up menu when the appropriate track is chosen in the left pop-up menu. When
you choose Chapters in the right pop-up menu, Previous and Next buttons appear; you can use these to
move sequentially from one chapter to another. (These buttons are useful when the controller is hidden,
as described in “Changing the controller “ later in this chapter.

INTERACTING WITH QUICKTIME VR MOVIES

When you open a QuickTime VR movie you’ll see that it, too, has a set of buttons along the bottom. Unlike
those for standard QuickTime movies, however, these buttons are not the primary means of controlling movies.
With QuickTime VR movies, you simply press and drag across the movie image itself. The buttons on the VR
controller supplement this basic action.

QuickTime VR controller
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Looking around in panoramic movies

Panoramic movies are those in which you, the viewer, are placed in the center of a space, and can look around
that space. You do so by pressing the mouse button and dragging across the image in the direction you want to
look.

Dragging a QuickTime VR panoramic movie

Turning objects around in object movies

With a QuickTime VR object movie, you press the mouse button to grab the object. You can then drag to spin
the object around to see it from many angles.
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Dragging a QuickTime VR object movie

Finding and using hot spots

Both panoramic and object movies may have hot spots, areas that when clicked cause some other action to
occur. Most frequently a hot spot links to another node (another panorama or object movie), but it may also be
used to trigger any other action, such as opening a Web page.

To tell where hot spots are located do one of the following:

• Move your pointer around the movie image. When moved over a hot spot, the pointer changes (typically
from a bullseye or arrow to a graphic that includes an upward-pointing “squished” arrow or a pointing
hand. )

QuickTime VR hot spot pointer for jumping to another node

Note: There are a variety of different pointers that can be used for hot spots. Clicking some hot spots while
in MoviePlayer triggers no action; these are hot spots that are defined but assigned no action. They can be
assigned an action on a Web page or in a multimedia authoring application.

• Press the Show Hot Spots button in the movie controller. (The button has a question mark above a
squished arrow.) While you press the button, hot spots are highlighted with translucent blue rectangles.
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Show Hot Spots button

Movie with hot spot highlighted

• Double-click the Show Hot Spots button. The button stays down; hot spots are highlighted with
translucent blue rectangles as you drag in the movie window.

If you jump to another node when you click a hot spot, the far left button in the controller becomes active. This
is the Hot Spot Return button. You use it to return to the precise point where you clicked the hot spot that took
you to the current node.

QuickTime VR Hot Spot Return button

Zooming in and out

You can zoom in or out of both panoramas and object movies. To do this, you use the two Zoom buttons which
look like magnifying glasses (one with a “+”, one with a “-”).

Zoom buttons in a QuickTime VR movie

The pointer must be over the image to zoom in or out.

Keyboard shortcuts: Press the Shift key to zoom in; press the Control key to zoom out.
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Moving zoomed-in objects

The Object Moving button (the far right button at the left side of the controller) works only in object movies;
it’s for moving your viewing window once you have zoomed in to an object. When you click the button, the
pointer changes to the figure on the button; then when you press and drag across the image, the viewing window
shifts, but the object remains in a single rotational position.

To return to normal viewing, you need to click the Object Moving button again.

Object Moving button

Keyboard shortcut: Hold down the Ctrl and Alt keys and drag to move your viewing window around a
zoomed-in object.

CHANGING WINDOW SIZES

All movies with a visual track have a “normal” size, which is the size at which the movie was originally created.
In MoviePlayer, you can resize movie windows using menu commands or using the mouse.

Note: When you resize a movie window, most visual elements in the window scale accordingly. How-
ever, this is not the case for text tracks that have been set not to scale (see “Creating a text track from a
text file” in Chapter 5) and timecode tracks.

Menu options for resizing

You can resize the movie window using commands in the Movie menu.

To resize the movie to half its normal height and width:

• Choose Half Size from the Movie menu.

To resize the movie to double its normal height and width:

• Choose Double Size from the Movie menu.

To make the movie window as large as possible without cutting off any of the image:

• Choose Fill Screen from the Movie menu.

This command fills as much of your screen as possible without changing the movie’s proportions. The title bar
and controller remain visible. (You may have to move or hide your Taskbar to see the controller.)

In general, you get the best performance if you play your movie at its normal size. If you resize a movie with a
video track to make it larger, the quality of the movie may decrease, giving you a very blocky effect. Also, the
motion may be choppier because the computer cannot play as many frames at this larger size. If you must
resize, however, Double Size is usually better than Fill Screen, as movies are optimized to play at dimensions
that are multiples of their normal size.
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To return the movie to its original size:

• Choose Normal Size from the Movie menu.

The menu options for resizing movie windows are available for all movies with a visual component, including
QuickTime VR movies. They are dimmed for audio-only movies.

Direct window manipulation

As with windows in other applications, you can use elements of a MoviePlayer window itself to change its size.

To make the movie window larger or smaller, do either of the following:

• Place your pointer over the window border until it changes to a double-headed arrow, then drag in or
out.

• Press the lower-right corner of the window (called the Grow Box in QuickTime VR movies) and drag in
or out.

Resizing a movie by dragging on a window border

If you drag the window border you will see only the moving border as you drag. If you drag the lower-right
corner, the movie image will be resized as you drag.

QuickTime is optimized to play at certain sizes.
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To change the movie window to an optimal size:

• Hold the Ctrl and Alt keys as you drag the lower-right corner of the window.

If you drag out, the movie height and width snap to double size. If you have a large enough monitor or small
enough movie, you can continue to drag beyond double size, and the movie frame size triples, then quadruples,
and so on. Alternatively, you can drag in, to make a movie three-quarters, then one-half, then one-fourth its
original size.

When you resize a movie window by dragging the lower-right corner, the original proportions of the movie are
maintained.

To resize the movie window without maintaining the original proportions, do one of the following:

• Hold down the Shift key as you drag the lower-right corner of the window.

• Resize by dragging a window border.

A movie resized disproportionately

To return the movie window to correct proportions:

• Hold down the Ctrl and Alt keys as you click in the lower-right corner of the movie window. (This does
not work if your pointer is exactly on the window border.)

The Maximize button, located at the top of the movie window, is also useful for resizing.

Maximize button

To fill the screen with the movie window (altering the window proportions if necessary):

• Click the Maximize button.

Once you have maximized a window, a Restore button appears in place of the Maximize button.

Restore button
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To return the movie window to the size it was before you maximized it:

• Click the Restore button.

PRESENTING MOVIES 

MoviePlayer has a Present Movie option that lets you play your movie on your monitor with nothing else
around it. It’s an effective and often more dramatic way to show your movie on the screen. If your computer can
send images on the monitor to a VCR, this is an ideal way to save movies onto videotape, a process often
referred to as printing to video.

Presenting time-based movies 

When you use the Present Movie option with time-based movies, no menu bar or movie controller shows, and
the movie simply plays from the current frame to the end.

A movie shown using the Present Movie option
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To present a movie:

1. With your movie open in MoviePlayer, choose Present Movie from the File menu.

The Present Movie dialog box appears.

2. Choose your settings:

• You can leave the movie size as Normal, or choose Double, Half, Full Screen, or Current. (If your
choice is Normal, Double, or Half, and your monitor and system software support switching resolutions,
QuickTime will automatically switch your screen resolution to the size that is closest to, but not smaller
than, the movie’s size. Thus, the movie may appear larger than expected. If you choose Current, the
movie will always appear the same size as it is currently.) Enlarging the movie for playback by choosing
Double or Full Screen in the Present Movie dialog box usually produces better results than if you resized
the normal movie window, as described earlier in this chapter. Of course, playback performance depends
on your computer’s hardware.
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• Choose Normal or Slide Show mode. In Normal mode, the movie plays from the current frame to the
last frame. When you play the movie in Slide Show mode, the movie advances from frame to frame only
when you click. No audio plays. Slide Show mode is best suited to QuickTime movies composed of a
series of still images or text-based screens, rather than those meant to be played as motion video.

3. Click the Play button.

Your screen goes black and the movie appears in the center of the screen. In Normal mode, the movie plays. In
Slide Show mode, the current frame of the movie appears, but the rest of the movie doesn’t automatically play.

To stop the movie while it’s being presented in Normal mode:

• Click the mouse button.

To advance one frame in Slide Show mode:

• Click the mouse button.

To step back one frame in Slide Show mode:

• Double-click the mouse button.

You can also use the arrow keys to step through the presentation forward and backward.

To stop the movie while it’s being presented in Slide Show mode:

• Press the Esc key on your keyboard.

You can also type Ctrl-period.

Presenting QuickTime VR movies 

When you use the Present Movie option with QuickTime VR movies, the movie appears in the center of a black
screen, as with a standard time-based movie. However, the VR controller is visible.
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A QuickTime VR movie shown using the Present Movie option

To present a QuickTime VR movie:

1. With your movie open in MoviePlayer, choose Present Movie from the File menu.

The Present Movie dialog box appears.

Present Movie dialog box for QuickTime VR movies

2. Leave the movie size as Normal, or choose Double, Half, Full Screen, or Current. (If your choice is Normal,
Double, or Half, and your monitor and system software support switching resolutions, QuickTime will
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automatically switch your screen resolution to the size that is closest to, but not smaller than, the movie’s size.
Thus, the movie may appear larger than expected. If you choose Current, the movie will always appear the same
size as it is currently.)

3. Click the Play button.

Your screen goes black and the movie appears in the center of the screen, with a QuickTime VR controller
below it. You can control the movie as your would normally.

To exit a QuickTime VR movie in Present Movie mode:

• Press the Esc key on your keyboard.

You can also type Ctrl-period.

OTHER MOVIE PLAYING OPTIONS

The movie controller and menus in MoviePlayer provide access to other interesting viewing options for movies.
Some of these features are useful, and others are just fun. Most apply only to time-based movies.

Text track searching 

In the previous chapter, we introduced you to the QuickTime text track. Since the data in a text track is stored as
text (i.e., not as a graphic), you can search through it for certain key words. This allows you to navigate to
precise points in movies that have text tracks.

MoviePlayer has a Find command that can be used on any movie with a text track.

To locate specific text in a movie with a text track:

1. Choose Find from the Edit menu.
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2. Type the word you’re looking for and click Find.

Typing text to search for

The movie jumps to the point where the text is located and highlights the text string you typed. If the text is not
in the text track, you hear an alert sound.
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Highlighted text in the text track

Once text is found, you can choose Find Again from the Edit menu to jump to the next place the text occurs. To
find a previous instance of the text, choose Find from the Edit menu and, in the Find dialog box, click the
Backward button before clicking the Find button.

Text searching is particularly useful when analyzing movies. It also works well as an indexing method. In
Chapter 6, where you’ll find information about how to add a text track to a movie (see “Adding text”), you’ll
also see how to make the text track invisible (see “Disabling and Enabling Tracks”); a text track can be searched
even if it is invisible.

Choosing a language

A QuickTime movie can have a set of tracks that are alternates for each other. The most common use of this
feature is to provide text tracks and/or sound tracks in more than one language.

To choose the desired language in a movie with alternate language tracks:

1. Choose the Choose Language command from the Movie menu. (If the movie does not have alternate
language tracks, Choose Language is dimmed.)

A dialog box appears that contains a list of languages.
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Choose Movie Language dialog box

2. Select the language of your choice and click OK.

Only the appropriate tracks play.

For information on how to define alternate tracks and assign languages to those tracks, see “Alternate Tracks” in
Chapter 6.

Continuous and backwards play 

A looping movie is one that repeats continuously until you pause it.

To make a movie loop:

1. Choose Loop from the Movie menu.
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2. Play the movie.

The movie plays to the end, then returns to the beginning and starts again. It continues to loop until you pause it.
The movie loops this way each time you play it until you turn looping off.

To turn looping off:

• Choose Loop from the Movie menu, so the checkmark is removed.

Another fun (and somewhat silly) thing to do is to make your movie play forward then backward. This is
sometimes called palindroming.

To make a movie play forward and backward continuously:

1. Choose Loop Back and Forth from the Movie menu.

2. Play the movie.

The movie plays forward then backward continuously until you pause it.

To turn off continuous forward and backward play:

• Choose Loop Back and Forth from the Movie menu, so the checkmark is removed.

You can also make a movie play backward. However, most movies do not play smoothly backward.
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To make a movie play backward, do one of the following:

• Hold down the Ctrl key and click the left Step button or press the Left Arrow key.

• Hold down the Shift key and double-click the movie image.

Playing all the frames in a movie 

If a movie contains more frames per second than the computer on which it is being played can handle,
QuickTime skips or drops frames to enable the movie to stay in time. However, if you want to see every frame,
regardless of how long it takes, you can do so.

To play a movie so that no frames are dropped:

1. Choose Play All Frames from the Movie menu.

2. Play the movie.

All of the frames in the movie are shown. Audio is not played, since it might not be possible for the video and
audio to stay synchronized.

If you have a slow computer, the movie may play in slow motion. For example, a 10-second movie may take 15
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seconds to play if you choose to play all the frames on a computer that is too slow to play the movie at its true
frame rate. However, if you use a fast computer or play a movie with a low frame rate, there will likely be no
slowdown when you tell the system to play all frames. (Of course, this means that all the frames probably
appear during normal playback.)

To return the system to normal playback:

• Choose Play All Frames from the Movie menu, so the checkmark is removed.

Playing all open movies 

If you have multiple movies open you can play and pause them all at once with a single menu choice.

To play all open movies:

• Choose Play All Movies from the Movie menu.

All open movies play. However, by default MoviePlayer plays only the audio from the frontmost window; to
change this, use the MoviePlayer Preferences dialog box; see “MoviePlayer Preferences” later in this chapter.

To pause all open movies:

• Choose Stop All Movies from the Movie menu.

Scratching

One of the neatest features hidden in the movie controller is the jog shuttle or scratching feature. You can make
a movie play forward or backward at a rate faster or slower than normal.

To play the movie at a faster or slower rate than normal:

1. Hold down the Alt key and press either of the Step buttons.

A small slider, called the scratching slider, appears.

Scratching slider

2. Drag the slider to the right or left.

When the slider is in the center the movie stops. As you move the slider to the right of center, the speed
increases , from stopped to slow motion to normal speed to two-and-a-half times normal playback speed. As
you move the slider to the left of center, the movie plays backwards, from slow motion (when near the center) to
two-and-a-half times normal backwards speed (at the far left).

Notice the difference between using this slider and the slider that is on the play bar. When you use the slider on
the play bar, you don’t hear audio.
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If you let go of the mouse button when scratching, the movie continues to play at the specified speed with
sound. This technique also works when you play the movie backward, although the movie generally doesn’t
play as smoothly.

QuickTime normally plays a movie so that one second of the movie happens in one second of real time. When
you use the jog shuttle option to increase the speed of a movie beyond normal playback speed, you are telling
QuickTime to play the movie so that each second of movie happens in less than one second of time. QuickTime
may have to drop a lot of frames to do this.

Jumping to the beginning or end

It is sometimes convenient to be able to jump quickly to the beginning or end of a movie without using the
slider.

To jump to the beginning or the end of a movie:

• Hold down the Ctrl and Alt keys and click the left or right Step button.

Muting the audio

You can turn the audio all the way down without using the volume slider.

To mute the audio in a movie:

• Hold down the Ctrl and Alt keys and click the Volume Control button.

You should see no lines emanating from the speaker. When you play the movie, you hear no audio.

To reset the movie to its original volume:

• Hold down the Ctrl and Alt keys and click the Volume Control button again.

Audio overdriving

Sometimes when you play a QuickTime movie, the audio is not as loud as you want it to be, even when you set
the volume slider to its maximum. You can “overdrive” the audio, which is essentially like setting the audio to
11 when the scale only goes up to 10.

To overdrive the audio:

1. Hold down the Shift key and click the Volume Control button.

The volume controller appears with two black horizontal lines through it. The lower line represents the normal
maximum volume. The higher line represents double the normal maximum volume. The top of the slider
represents three times the normal maximum volume.
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The volume controller showing percentages of normal volume

2. Drag the volume slider up to the top black line or higher, then release the mouse button.

When you play the movie again, the audio level is quite a bit higher. Unfortunately, overdriving the audio may
also result in poor performance and poor audio quality when you play the movie.

Changing the controller 

It’s possible to change the controller for a individual movie.

To change the movie controller for a movie:

1. Choose Get Info from the Movie menu.

2. In the movie info window, choose Movie from the left pop-up menu and choose Controller from the right
pop-up menu.

3. Select a new controller in the list:

• For a QuickTime VR movie, you can switch to the Movie Controller, which is the standard time-based
controller. When you click the Play button for an object movie, the object rotates automatically,
appearing in all possible positions. (Switching to the Movie Controller also enables you to do minor
editing on the movie, such as adding additional tracks; see “Adding new tracks to a QuickTime VR
movie” in Chapter 6.)

• For a QuickTime VR movie you can switch between different VR controllers, but there is generally not
much reason to do this.

• For all movies with a visual component, you can switch to the None Controller. This hides whatever
controller is visible. You can still play standard time-based movies by double-clicking the movie
window. You also play QuickTime VR object movies by double-clicking them; the movie plays,
showing the object in all positions. You can’t interact with QuickTime VR panoramic movies if they
have no controller.

• For movies with only audio, you can’t switch the controller.
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MOVIEPLAYER PREFERENCES 

You can open MoviePlayer’s Preferences dialog box by choosing Preferences from the File menu. Currently,
there are only two checkboxes in this dialog box.

If “Play sound in background” is checked, any audio from a playing movie will continue to play even when the
movie window is in the background (another window on your screen or another application is active).

If you check “Only front movie plays sound”, then the sound from movies other than the frontmost window
won’t be audible. If this option is not selected, you can play several independent audio files at once; you can
vary the volume of each to get a desired balance.

MoviePlayer Preferences dialog box
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MOVIE CONTROLS SUMMARY

The movie controller, in conjunction with various keyboard and mouse actions, gives you tremendous flexibility
when playing movies.

Summary of the movie controller
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Chapter 4: Movie Editing Basics

So far we’ve only talked about how you can view movies. In this chapter, we cover the use of MoviePlayer for
simple editing of standard time-based QuickTime movies—copying and pasting portions of them, deleting
segments, and combining multiple movies. We also show how to add and change components of a movie file
that aren’t part of the movie content. In the following chapters we describe some slightly more complicated
techniques involving individual tracks.

• Cut, Copy, and Paste 

• Copying the current image in a movie 

• Selecting and copying part of a movie 

• Creating a new movie and pasting something into it 

• Combining two movies 

• Deleting parts of a movie: clearing and trimming 

• Replacing parts of a movie 

• Checking the content of a selection

• Editing Non-Movie Data 

• Setting the poster 

• Setting the preview 

• Annotations 

• Saving 

• File dependencies 

• Checking file dependencies 

• Saving movies for the Web 
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CUT, COPY, AND PASTE

If you’ve used word-processing software before, you’re no doubt familiar with the Cut, Copy, and Paste
commands. These commands are actually used in all types of applications, with all sorts of data. QuickTime
applications, including MoviePlayer, are no exception.

MoviePlayer’s Edit menu with Cut, Copy, and Paste commands

Copying the current image in a movie

The visual image that appears in your movie window can be copied in order to subsequently be pasted into
another file.

To copy the current image in the movie window:

• Choose Copy from the Edit menu.

The copied image can now be pasted into another movie window (see sections below on “Creating a new movie
and pasting something into it” and “Combining two movies”) or into any application that handles images.

Selecting and copying part of a movie 

When you want to copy text in a word processor, you first select or highlight the portion of the text you want to
copy by dragging across it.
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Text selected in a word-processing application

The process of making a selection is only slightly less direct when you’re working with QuickTime data. Recall
that the play bar represents the length of the movie. You select a portion of the movie by selecting an area of the
play bar.

To select a portion of a movie:

1. Move the slider to the point in the movie where you want the selection to begin.

2. Hold down the Shift key and drag the slider until you’ve reached the point in the movie where you want the
selection to end.

As you drag, the portion of the play bar that you have dragged along turns black. This represents your selection.

3. Release the mouse button and Shift key.

The entire portion you selected remains black.

Selected movie data in the play bar

Tip: You may find it easier and more precise to select a portion of the movie by using the Step buttons
(or the Right and Left Arrow keys) while holding down the Shift key. You can also hold down the Shift
key, play the movie, and release the Shift key or press the Pause button when the desired portion of the
movie has played.

The frame that you see when you’re finished making a selection is the first frame that follows the selection; it
won’t be included in the selection.

To select a whole movie:

• Choose Select All from the Edit menu.

To cancel a selection, do one of the following:

• Click anywhere in the Play bar.

• Choose Select None from the Edit menu.

Once a portion of the movie is selected, you can copy or cut that portion and paste it elsewhere, as you would
with any other application.

To copy a selected portion of a movie:

• Choose Copy from the Edit menu.

The copied portion of the movie is ready to be pasted elsewhere.

Note: You can paste copied movie data into any application that handles images; the first frame of the
selection you copied will be pasted as a still image.
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Creating a new movie and pasting something into it 

The actions for making a new movie and pasting previously copied data into it are also identical to those in
other applications.

To create a new movie:

• Choose New from the File menu.

An empty movie file opens called “Untitled 1”.

To paste previously copied data into a movie:

• Choose Paste from the Edit menu.

After you paste into an empty movie, the entire play bar is selected. An image from the data you copied appears
in your new movie.

New movie after copied movie data has been pasted into it
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Keyboard shortcuts: To cut, press Ctrl-X. To copy, press Ctrl-C. To paste, press Ctrl-V.

Combining two movies 

To combine two movies, you simply copy from one and paste into the other.

Tip: To move from movie window to movie window, press the Tab key.

Before you paste, you should position the slider so that you see the frame that you want to appear immediately
after the pasted data. When you paste, in most cases the copied movie frames are pasted immediately before the
frame you see. The one exception is when the slider is at the very end of the movie, in which case the data is
placed after the frame you see.

Movie after additional data has been pasted into it

Note: As long as a movie file is not empty, you can also paste data copied from applications that handle
text or images. Such data is given a default duration of two seconds when pasted. Images are resized and
reproportioned to fit into the movie window’s current dimensions. Text is centered in the movie window.
If the text is too long the movie window’s height is extended as much as possible on your current screen,
and as much text as will fit in the window is visible.
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Deleting parts of a movie: clearing and trimming 

There are two basic ways to delete sections of a movie. You can select a section and delete it, or clear it; or, you
can delete everything but the selection, or trim.

To delete a section of a movie:

1. Select the section you want to remove.

2. Choose Clear from the Edit menu.

Keyboard shortcut: To remove a selected section, press the Delete key or backspace key on the key-
board.

If you’d rather keep what’s in the selection and get rid of everything else, you can use the trim function.

To delete everything but the selected area:

1. Hold down the Ctrl and Alt keys and open the Edit menu.

Trim replaces Clear in the Edit menu.

2. Choose Trim.
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Trim is available if you hold down the Ctrl and Alt keys.

Everything but the selection is deleted.

Tip: Use the Undo command in the Edit menu to return the movie to its state before your last action.

Replacing parts of a movie 

If you have previously copied movie data, you can replace portions of a movie with the copied data.

To replace a section of a movie with previously copied data:

1. Select the section of the movie you want replaced.

2. Hold down the Shift key and open the Edit menu.

Instead of Paste, Replace appears in the Edit menu.
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Edit menu when Shift key is held down

3. Relase the mouse button.

The selection made in step 2 is replaced with the data you had previously copied. This may make the movie
shorter or longer depending on whether what was copied is shorter or longer than what’s in the selection.

Checking the content of a selection 

Sometimes you want to be sure of precisely what content is contained in your current selection before pasting it
or deleting it. MoviePlayer makes it easy to check the content of a selection by providing a way to play only the
selection.

To play only the selected portion of a movie:

1. Choose Play Selection Only from the Movie menu.
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2. Play the movie.

When you play the movie, only your selection plays, so you can verify that precisely what you want to copy or
delete has been selected.

You may also want to check the frame that occurs at the very beginning or end of a selection.

To jump to the beginning or end of a selection:

• Hold down the Ctrl and Alt keys and click either the left or right Step button.

You can then use either of the Step buttons, without the Ctrl and Alt keys, to move one or more frames to ensure
that the right thing occurs before or after the paste.

Tip: It is also helpful sometimes when editing to know the amount of time represented by your selection, as well
as the precise point in time of the slider. The Time panel of the movie info window (covered in chapter 2)
provides this information.
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EDITING NON-MOVIE DATA 

You can edit several elements of a movie file that aren’t part of the movie content. These elements include the
preview, the poster, and annotations.

Setting the poster 

The poster is a specific image from a movie. By default, it is the first frame of the movie, or the image that
appears when the movie starts.

The poster appears in the Movie Information dialog box, which you open by choosing Show Copyright from the
Movie menu.

To change the poster:

1. Use the slider (or any other method) to move to the location in the movie that has the image that you want to
be the poster.

2. Choose Set Poster Frame from the Movie menu.

A new poster is selected. This command works even for visual track types that technically aren’t composed of
frames, such as the 3D track. MoviePlayer uses whatever image is visible when you choose Set Poster Frame.
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To check to make sure the correct image is the poster:

1. Move the slider to a random point on the play bar.

2. Choose Go To Poster Frame from the Movie menu.

The slider moves to the location that you set as the poster.

Setting the preview 

In the dialog box that appears when you open a movie file from within QuickTime-aware application like
MoviePlayer, there is a preview area on the left. If the file selected has a visual component, the image shown in
the preview area may be a representative image from the movie or a portion from the movie that can be played.
If the file clicked has only audio, you see only a truncated controller in the preview area; you can click the play
button to hear a preview of the audio.

Open dialog box with preview

The preview, by default, is the first ten seconds of the movie. You can, however, define a different portion of the
movie as the preview.

To specify a new preview:

1. Select the portion of the movie that you’d like to use as a preview.

2. Choose Get Info from the Movie menu.
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3. In the movie info window, choose Preview from the right pop-up menu.

The Preview panel appears.

Preview options in info window

4. Click the button labeled “Set Preview to Selection.”

When the file is later selected in the Open dialog box of any QuickTime-aware application, the preview you
selected is available. You can check the preview while the movie is still open.

To play a movie’s preview while the movie is open:

1. In the Preview panel, click the “Set Selection to Preview” button.

2. Choose Play Selection Only from the Movie menu in the menu bar.

3. Play the movie.

Only the portion of the movie defined as a preview plays.

If you decide you don’t want any preview defined, you can remove the preview.

To remove a preview:

• Click the Clear Preview button in the Preview panel in the info window.
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Annotations 

As mentioned in Chapter 2, QuickTime movies can contain annotations about many aspects of the movie. You
can assign values to the following properties: Artist, Author, Comment, Copyright, Creation Date, Description,
Director, Disclaimer, Full Name, Host Computer, Information, Make Model, Original Format, Original Source,
Performers, Producer, Product, Software, Special Playback Requirements, Warning, Writer, and Edit Date.

As you edit a movie and before you distribute it, it is useful to annotate your movie with this information.

The annotations for Copyright, Full Name and Information also appear in the Movie Information dialog box,
which you open by choosing Show Copyright from the Movie menu.

To add new annotation data to a movie:

1. Choose Get Info from the Movie menu. In the movie info window, choose Annotations from the right pop-up
menu.

2. Click the Add button.
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The Add Annotation dialog box appears.

3. Select any one of the properties in the scrolling list at the top of the Add Annotation dialog box and type text
for that property in the field at the bottom of the dialog box.

4. When you’re done typing, click Add.

The property you added appears in the list of properties in the Annotation panel. When a property is selected, its
data appears in the field at the bottom of the panel.

To change annotation data:

1. In the Annotations panel, select the property for which you wish to change data and click Edit.

The Edit Annotation dialog box appears containing the current text assigned to the property.

2. Edit the text and click OK.

To delete annotation data:

1. In the Annotations panel, select the property you want to delete and click Delete.

An alert dialog box appears asking if you really want to delete the property.

2. Click Delete.

SAVING 

When you’re done editing a movie, you need to save it.

To save an edited movie file that has been saved before:
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• Choose Save from the File menu.

The file is saved under its current name.

Note: If you have resized your movie window, as described in Chapter 3, the movie is saved at the
current movie dimensions. Also, if you have selected Loop, Loop Back and Forth, Play All Frames (all
described in Chapter 3), or Play Selection Only (described earlier in this chapter), these settings will
remain when the movie is saved.

To save an edited movie file that has never been saved before:

1. Choose Save or Save As from the File menu.

A Save As dialog box appears.

MoviePlayer’s Save As dialog box

2. Name the file and navigate to the location on your hard disk where you want to save it.
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3. Leave “Save normally” selected or select “Make movie self-contained”, then click Save.

To understand whether you should save a movie normally or make it self-contained, you should understand file
dependencies, covered in the following section.

File dependencies

When you save a movie in MoviePlayer, you are given a choice of saving your movie “normally” or saving it as
a “self-contained” file. It’s important to understand the differences between these.

When you save normally, your movie may not contain all the data you see played in the movie. If you paste data
into a movie and then save normally, the movie file contains information about where the original version of
that data can be found. The file has a dependency: it depends on the file or files from which the original frames
were copied. These are called reference files.

If a reference file is not available, there will be problems opening the movie. (An alert message will tell you this
and give you a chance to locate the file. If the file has simply been renamed or moved, you can locate it and all
will be fine. If it’s been deleted or is on a CD-ROM or on another volume that you don’t have access to, you
won’t be able to play the movie.)

When would you want to save a movie with dependencies? If you’re saving a movie before you’re completely
finished editing it, you may want to save it normally to save disk space. Also, if you are reusing parts of movies,
it makes little sense to store them multiple times. If, for example, you have a set of movies all of which have
some portion (e.g. an opening or title) in common, you can save space by including that common portion as a
reference.

In general, however, you should remember to save any final movies as self-contained.

Note: If you delete segments from a movie and then save normally, no data will be missing but your file
will be larger than it needs to be. This is because the deleted data doesn’t actually go away; the file
contains the information about what parts of the movie shouldn’t be played. If you have a movie from
which you have deleted segments, you should save as a self-contained file. In doing so, you will actually
get rid of the data that you deleted. (You should use the Save As command in the File menu rather than
the Save command to be able to save as a self-contained file.)

Checking file dependencies

You can use MoviePlayer’s info window to show file dependencies for a movie.

To see which files a movie is dependent upon:

1. Choose Get Info from the Movie menu.

2. In the movie info window, choose Files from the right pop-up menu.
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The Files panel when the movie has no dependencies

• If only one file is listed, it is usually the file currently open and active. This means the movie is
dependent only on itself.

• If the listed file doesn’t match the name of the file that’s open, or if more than one file is listed, the
movie depends on other files to play. You can double-click a file name to open any of these reference
files.
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The Files panel when the movie has dependencies

If a movie has dependencies, you can also determine which specific tracks are dependent on other files.

To check dependent files for a single track:

• In the movie info window, choose the track from the left pop-up menu and choose File from the right
pop-up menu.

A panel showing reference files appears.
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Chapter 5: Translating to and from QuickTime

QuickTime supports a large number of different media file types. Because of this, you can use MoviePlayer to
create QuickTime tracks from a wide variety of non-QuickTime media files. (QuickTime provides
comprehensive capabilities to operate on media, once in the QuickTime file format; we cover these capabilities
in the next chapter.) In addition, you can export QuickTime movies to a number of non-QuickTime file formats.
In this chapter, we cover how you use MoviePlayer to do these translations to and from the QuickTime file
format.

• Creating QuickTime Tracks From Other Media Files 

• Opening media files 

• Importing media files 

• Creating a video track from an animation file 

• Creating a video track from one or more still images 

• Creating QuickTime tracks from other video formats 

• Creating a sound track from a sound file 

• Creating a text track from a text file

• Creating a music track from a standard MIDI file

• Creating a music and a text track from a Karaoke file

• Exporting Tracks 

• Exporting a sound track 

• Exporting a music track

• Exporting a single image 

• Exporting as a QuickTime movie 

• Exporting as DV 

• Exporting a text track to a text file 
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CREATING QUICKTIME TRACKS FROM OTHER MEDIA FILES

There are two broad categories of media file formats that can be turned into QuickTime movies:

• Media files that QuickTime can open directly. QuickTime understands files in many media formats.
Opening one of these files is essentially identical to opening any QuickTime movie.

• Media files that need to be imported. With files in some other media formats, QuickTime must first
convert all the data in the file into a separate QuickTime movie file before you can use the file in
MoviePlayer.

Opening media files

You can directly open and play many non-QuickTime files with MoviePlayer. Video file formats that
QuickTime understands include AVI and DV. Animation formats include FLI, FLC, and Animated GIF. Audio
formats include WAV, AIFF, and AU. Still image formats include GIF, BMP, and TIFF. There are others; see the
appendix for a complete list.

You open these files in MoviePlayer using the Open command in the File menu; the Open dialog box will have
a Convert button instead of an Open button. When you click the Convert button, the file opens just as if it were
a QuickTime movie. (This process is sometimes referred to as opening the file in place.)

Open dialog box when file can be opened directly
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Importing media files

File formats that QuickTime cannot open directly, but which it can convert, include text, PICS, MIDI, and
Karaoke. (See appendix for a complete list.) The process for importing these files requires a few more steps
than for those that can be opened directly.

To import files that need to be converted:

1. Choose Import from the File menu.

An Open dialog box appears.

2. Locate and select the file you’d like to import.

The Open button changes to Convert. (The name of this button is followed by ellipses to indicate that a further
step is required.)

Open dialog box when the file needs to be converted

3. Click Convert.

A Save dialog box appears, with a filename already provided (the original name of the file with the extension
.MOV appended).
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Save dialog box for file being converted to QuickTime format

4. Select a folder in which to save the file, and change the name if you’d like.

For certain media types, an Options button will be available. If you click the Options button, a dialog box
appears in which you can select various settings specific to the media type you’re importing. (We’ll explain
these settings in the sections that follow.) After you select settings in the dialog box and click OK, you are
returned to the Save dialog box.

5. Click Save.

A new QuickTime file is created, saved, and opened in MoviePlayer.

Note: You can use the Open command instead of the Import command to access some media files that
need to be imported, but you’ll follow the same steps as described above. This allows you to import
some files even if using MoviePlayer Lite, which does not have an Import command.

Creating a video track from an animation file

QuickTime can open or import files in many of the major animation formats used on Mac OS and Windows
computers.

You can open FLC, FLI, and Animated GIF files as you would any QuickTime file, using the Open command in
the File menu.
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For PICS files, follow the basic import procedure (covered in the section “Importing Media Files,” earlier). If
you click the Options button in the Save dialog box, a dialog box appears that allows you to select compression
settings. If you don’t change any of these settings, the resulting movie will be compressed with the Video
compressor at 12 frames per second. (See the appendix for an explanation of compression options.)

The Compression Settings dialog box provides options when importing a PICS animation

Creating a video track from one or more still images

There are two ways to create a video track from still images. You can open or import a single image to create a
one-frame video track. Or, you can import a set of images numbered in a sequence; each will be a frame in the
resulting video track.

To create a video track from a single image:

• For most image formats (SGI, Photoshop, BMP, GIF, JPEG, JFIF, MacPaint, Targa, TIFF, PNG, and
3DMF) use the Open command in the File menu to open the file directly.

• For PICT files, follow the basic import procedure (covered in the section “Importing
Media Files,” earlier).

If you click the Options button in the Save dialog box, you’ll see a Compression Settings dialog box that
lets you select a method of compression for the resulting movie. However, you should typically leave
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the default values. Read the appendix for more information on the choices in the Compression Settings
dialog box.

Compression Settings dialog box for importing still images

If you open or import a still image in MoviePlayer, you get a single-frame QuickTime movie. The frame (and
thus the movie) has a duration of one-fifteenth of a second.

You can also convert a group of images into a single QuickTime movie; each image becomes a separate frame.

To create a movie from a series of images:

1. Name the still image files so that they have a common name with sequential numbers appended to this name
(e.g. picture1, picture2, picture3, etc.).

2. Choose Open Image Sequence from the File menu.

An Open dialog box appears.

3. Locate and select any one of the images you’d like to make into a movie and click Open.

An Image Sequence Settings dialog box appears.
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4. Choose a frame rate from the pop-up menu and click OK.

Your new movie appears.

The frame rate of the movie matches what you specified in step 4 above.

Creating QuickTime tracks from other video formats

AVI and DV video files can be opened directly in QuickTime, just as if they were QuickTime files.

If you open an AVI or a DV file, you get a QuickTime video track and, if the file contains audio, an audio track.

Creating a sound track from a sound file

QuickTime can directly open sound files of many formats, including AIFF, AIFC, AU, WAV, and Sound
Designer II, without first creating a new QuickTime file.

QuickTime can also import Macintosh System 7 sound files (with a .sfil extension) into the standard QuickTime
file format; these need to be imported.

If you’re not sure which format you have, choose the Import command from the File menu. When you select a
filename in the Open dialog box, the Open button changes to a Convert or a Convert... button. If the file is in a
format that can be opened directly, you’ll see a Convert button, which when clicked will cause the file to open.
If it needs to be converted and saved, you’ll see a Convert... button, and you will follow the basic steps for
importing a file, as described in the section earlier in this chapter, “Importing media files.”

Open dialog box with an audio file that can be opened directly
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No options are available when importing sound files.

Creating a text track from a text file 

You can create a QuickTime text track by importing any text file, as long as the file has been saved as “text
only.”

To import text to create a movie with a text track:

• Choose Import from the File menu, locate and select any text file, click the Open button, then save the
file.

A text track movie is created. The movie has default values for various font and window settings. The text is
white 12-point centered in the Application font on a black background. Each paragraph (delineated by a Return
character) is a separate frame of the movie, which lasts for two seconds.

Text movie with default settings

However, you don’t have to use the default values for the text settings.

To change the text settings:

1. Click the Options button before you save the movie file.

A Text Import Settings dialog box appears, where you can select your preferred settings.

• Use the Font, Size, and Align pop-up menus and the Style options to change basic text properties.

• Click the square next to Text Color or Background Color and use the dialog box that appears to select a
text color or a background color for the text track. (Click OK to return to the Text Import Settings dialog
box.)
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Text Import Settings dialog box

• Enter your own values for width or height, or select “best-fit” width or height. Best-fit width and height
result in a movie that is 160 pixels wide and tall enough to fit the longest line of text being imported.

• Select Anti-Alias to fuzz the edges of the characters. (This makes them look smoother when they’re
displayed in a large-size font.)

• Select Drop Shadow to place a drop shadow behind the text.

• Select Keyed Text to have a transparent background.

Anti-Alias, Drop Shadow, and Keyed Text and are good to use if you want to place the text over a video
track, though they require a lot of computing power to work, which will result in poor performance on
all but the fastest computers.

• Select Don’t Auto-Scale if you want the text to remain the size you defined even if the movie window is
resized.
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2. When you’ve made the changes you wish, click OK to close the Text Import Settings dialog box, then save
the file.

A text movie appears, with the properties chosen in the Text Import Settings dialog box.

Text movie with custom settings

Though it’s a little trickier, you can also specify an amount of time that you’d like each line of text to appear;
you don’t need to stick to the two second-per-frame default.

To change the duration of text frames:

1. In a text editor or word processor open the text file you’d like to import .

2. Add extra information to the file:

• On the first line, enter {QTtext}.

• On a separate line before each line of text, enter a time stamp value in square brackets (e.g.
[00:00:08.000]), indicating when that line of text should appear. The time you enter is the length of time
after the movie has started at which this line of text will appear. Time stamps are specified as
hours:minutes:seconds.1/600ths of a second.

• After the last line of text, enter a time stamp indicating the time at which you want the movie to end,
followed by a return.
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3. Save the file as a “text only” file. (Different text editors and word processors have different methods for
saving as text only; usually you’ll see an option in the Save dialog box.)

4. Import the movie using the basic import steps described at the beginning of this section.

Here is an example of the contents of a text file that you can import into MoviePlayer:

{QTtext}

[00:00:00.000]

Gettysburg Address

[00:00:08.000]

Fourscore and seven years ago,

[00:00:10.000]

our fathers brought forth upon this continent a new Nation,

[00:00:14.000]

conceived in Liberty,

[00:00:17.000]

and dedicated to the proposition

[00:00:20.000]

that all men are created equal.

[00:00:25.000]

Alternatively, you can enter time stamps that indicate how long each line of text should remain on the screen. To
do this put {QTtext} in the first line, {timestamps:relative} in the second line, [00:00:00.000] in the third line,
and a timestamp after each line of text. It would look like this:

{QTtext}

{timestamps:relative}

[00:00:00.000]

Gettysburg Address

[00:00:08.000]

Fourscore and seven years ago,

[00:00:02.000]

our fathers brought forth upon this continent a new Nation,

[00:00:04.000]

conceived in Liberty,
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[00:00:03.000]

and dedicated to the proposition

[00:00:03.000]

that all men are created equal.

[00:00:05.000]

Also, if you want to alter the text properties of your movie or individual frames, you can insert font, size, color,
and style tags.

To alter the text properties of text in a movie:

1. Create a text file as described above. At the beginning of the file (after the {QTtext} tag) or before individual
lines, add tags such as these:

• {font:Geneva} (to specify the font)

• {plain} or {bold} (to specify text style)

• {size:24} (to specify text size)

• {textColor: 65535, 0,0} (to specify text color—in this case, red)

• {backColor: 0, 65535, 0} (to specify background color—in this case, green)

• {justify:center} (to specify alignment)

2. Save the file as a text-only file, and import it into MoviePlayer using the import procedure described at the
beginning of this section.

If you’d rather not create a text file with tags yourself, you can import a simple text file (i.e. one without any
formatting) into MoviePlayer, then export it with text descriptors and time stamps, as described at the end of
this chapter in the section “Exporting a text track to a text file”. The file will be formatted appropriately, and
you can make changes or add descriptors in appropriate places, then reimport it.

Creating a music track from a standard MIDI file

QuickTime can import any standard MIDI file; most MIDI sequencer software saves files in this format.

To import a standard MIDI file:

• Follow the basic import steps: choose Import (or Open) from the File menu, locate the file, click Con-
vert and save the file.

Before saving, you can also click the Options button and select various settings in the Standard MIDI Import
dialog box.
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Standard MIDI Import Options dialog box

• If you want your music file to be able to play on computers that still use QuickTime 2.0 or QuickTime
2.1, check the “Compatible with QuickTime 2.0” checkbox.

• Click “Add silence at end” or “Add silence at beginning” to add one second of silence to the end or
beginning of the MIDI file you import.

• The Karaoke options at the bottom of the dialog box should be dimmed. See the next section for an
explanation of these options.

Creating a music and a text track from a Karaoke file

Karaoke files are files that contain synchronized music and lyrics. QuickTime can import KAR files, one format
of Karaoke.

When you import a KAR file, the MIDI information goes into a music track and the lyrics go into a text track.

To import a KAR file:

• Follow the basic import steps: choose Import (or Open) from the File menu, locate the file, click the
Convert button, and save the file.

Before saving the file, you can also click the Options button and select several settings.

When you click Options, you see the Standard MIDI Import Options dialog box with the Karaoke section
enabled.
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Standard MIDI Import Options dialog box with Karaoke options enabled

• See previous section for an explanation of options in the Music section.

• In the Karaoke section, make sure that the “Import lyrics as karaoke” checkbox is checked.

• To adjust the text settings, click the “Text options” button in the Karaoke section. You’ll see the standard
Text Import Settings dialog box (described in “Creating a text track from a text file,” earlier in this
chapter); here you can choose various text and color settings. (The defaults are plain, white, centered 12-
point text, in the Application font, on a black background.)

After you save the Karaoke file as a new movie, it opens in MoviePlayer. If you choose Get Info from the
Movie menu and open the left pop-up menu, you’ll see that the movie has a text track and a music track.

Movie info window showing tracks for imported Karaoke file



Chapter 5 QuickTime 3 Pro: MoviePlayer for Windows 95/NT 4 Page 85

EXPORTING TRACKS 

There may be times when you want to convert the media in your QuickTime movie to a non-QuickTime format.
QuickTime lets you export data in a large variety of formats. While other applications that use QuickTime may
provide access to a subset of these formats, MoviePlayer provides access to just about all of these formats.

In addition, MoviePlayer’s exporting capabilities allow you to change various features of QuickTime movies,
such as compression, while leaving the file format as a QuickTime movie. Finally, there are several export
options for converting from one media type to another (e.g. music to sound, sprite to video, text to video)

To export a movie or track:

1. Choose Export from the File menu

A Save dialog box appears. In the Export File As pop-up menu there’s a choice of several formats depending on
what track types are in the movie.
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The Save dialog box with the Export File As pop-up menu opened

2. Choose the file format you want.

Depending on the format you’re exporting to, the Options button may be available; use it to set options for the
exported file.

3. Click Save.

See the following sections for information about the kinds of files you can export and the options you can set
for each.

Exporting a sound track 

You can export a QuickTime sound track as a System 7 Sound, Wave, or uLaw file, as well as an AIFF file.

You might want to export a sound track in another format so you can use the track in an application that sup-
ports only a specific audio format. Another reason to export a sound track is that you can apply audio compres-
sion to the track when you export it; you can later open or import the compressed sound track to create a smaller
movie file.
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If you click the Options button in the Save dialog box a Sound Settings dialog box appears where you can select
settings for the exported sound data. (See the appendix for a description of the compression choices available
here.)

Sound Settings Dialog box

It may take quite a while to export a sound track.

Exporting a music track 

If you have a movie with a music track, you can export the music track, either as a standard MIDI file or as an
AIFF file.

If you export as MIDI, you can work with the file using MIDI software. There are currently no options available
for MIDI export.

If you export a music track as an AIFF sound file, there are sound settings options available; see the appendix
for an explanation of these. Exporting a music track to an AIFF file can take quite a long time. Also, the file is
likely to be from a hundred to a thousand times larger than the original QuickTime music file or an exported
MIDI file, depending on the options chosen when exporting.

Exporting a single image 

The Movie to Picture and Movie to BMP options export the current frame as a still image in PICT or BMP file
formats. The image is compressed; QuickTime must be installed on any system on which you want to open it in
order to decompress it.
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Exporting the current frame as a picture

The exported image contains everything that is visible in the current frame, even if the image is composed of
data from multiple tracks. For example, if a text track and a video track are visible, the exported image will
include both the video image and the text.

If you click the Options button in the Save dialog box, a dialog box appears where you can select a compressor,
number of colors, and quality. If the compressor you select is not included with QuickTime, that compressor (or
a corresponding decompressor) must be installed on the system on which you want to open the file. (See the
appendix for more information.)

Exporting as a QuickTime movie 

Exporting as a QuickTime movie consolidates all visual tracks (including text, sprite, and 3D) into a single
video track, and all sound tracks into a single sound track. (Music tracks are ignored.)

Since having multiple tracks often decreases performance exporting as a QuickTime movie may give you a
smoother-playing movie. It’s also a good way to change various settings of either an audio track or a video
track.

If you click the Options button in the Save dialog box, a Movie Settings dialog box appears that tells you the
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default settings that will be applied to both the video and audio track.

Movie Settings dialog box

The Settings buttons allows you to change these default settings. When you click Settings, the standard Com-
pression Settings dialog box appears (for the video track) or the standard Sound Settings dialog box appears (for
the sound track). If you click the Filter button, a dialog box appears in which you can choose and set various
visual effects. (See the appendix for information on these settings dialog boxes.)

If the checkbox labeled “Fast Start for the Internet” is selected, the exported movie is formatted properly for
Web playback. If this option is deselected, the export is faster and requires less hard disk space, but the movie is
not formatted properly for Web playback. If the Compress Movie Header checkbox is selected, the resulting
movie downloads and starts playing more quickly; however, this option is not compatible with versions of
QuickTime earlier than 3.0, so use it only if you are sure the movie will be played using QuickTime 3 or later.
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Exporting as DV 

You can export any QuickTime movie to a DV stream.

If you click the Options button, the DV Export Settings dialog box appears. Here you can select a video format
(NTSC or PAL). You can also select or deselect the Locked option for audio format. (Locked is the professional
variant of the audio format used in DV and is not compatible with consumer DV cameras.)

DV Export Settings dialog box

Exporting a text track to a text file 

You can export a text track to a standard text file by choosing Export from the File menu, then choosing Text to
Text in the Save dialog box. Each frame of text is placed on a separate line of the text file.

If you click the Options button, a Text Export Settings dialog appears. If you select the Show Text, Descriptors,
and Time option, you can export a file with time stamps and text descriptors included in the text. You would do
this if you want to make changes to the formatting of the text track then re-import, as described in the section
“Creating a text track from a text file”, earlier in this chapter.

If you click the Show Text, Descriptors, and Time button, more options appear in the Text Export Settings
dialog box.
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Extended Text Export Settings dialog box

In general, you can leave the options as they are and click OK. To match your personal editing preferences,
however, you may want to change the time stamps so they are shown relative to the start of the sample; this
means that each time stamp indicates the amount of time that the preceding line of text will appear. If you prefer
to view fractions of seconds as something other than the default of 1/600, type a different number here, too.

If you open the file in your favorite word or text processor, you’ll see various text descriptors (e.g. font, size,
color, style), and properties of the track (e.g. dimensions), which correspond to the settings made in the text
import settings dialog box. The rest of the file contains the text to be displayed with time stamps.

Text file showing text descriptors
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You can change any of the descriptor values, time stamps, or text lines in this file and reimport it, as long as the
first descriptor remains {QTtext}and you enter valid values for the descriptors and time stamps. (See the section
earlier in this chapter, “Creating a text track from a text file,” for more information.)
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Chapter 6: Track Editing

In Chapter 4 we covered basic editing techniques. These techniques treat a QuickTime movie as a single entity,
even though it might be composed of multiple tracks. In Chapter 5 we showed how to create individual tracks
by opening or importing files of various media types.

In this chapter, we show you how to manipulate movie tracks independently. We first explain how you can
decompose existing movies into separate tracks, and then show how to combine tracks to build new movies. We
also show how you can turn individual tracks on and off, as well as various other techniques for altering the way
individual tracks appear and behave.

• Pulling Tracks Apart 

• Extracting tracks 

• Deleting tracks 

• Combining Tracks With the Add and Add Scaled Commands 

• Adding new audio to a video movie 

• Adding text 

• Adding still image graphics to a movie 

• Adding new tracks to a QuickTime VR movie 

• Altering Visual Tracks 

• Adjusting the size, location, and orientation of visual tracks 

• Changing layers 

• Using graphics modes 

• Masking 

• Adjusting gamma in video tracks 

• Changing 3D tracks 

• Changing sprite tracks 

• Adding a custom color table 

• Altering Audio Tracks 

• Adjusting volume 

• Changing instruments in music tracks 

• Changing the Quality of Tracks 

• Preloading Tracks 

• Disabling and Enabling Tracks 

• Alternate Tracks 
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PULLING TRACKS APART 

Sometimes the media that you want is already contained in a QuickTime movie, but it’s combined with other
tracks that you don’t need. For example, you may want only the audio from an existing movie.

There are two basic ways to separate tracks: extracting tracks and deleting tracks.

Extracting tracks 

When you extract a track—or pull a single track out of a movie—you leave the original movie file intact and
produce a new file.

To extract a track from a movie:

1. Choose Extract Tracks from the Edit menu.

A dialog box listing all of the tracks in the movie appears.

2. Select the track you want to extract and click Extract.

A new, untitled movie opens. The movie has a single track (the one you extracted).

Tip: If a movie has more than one track, you can select more than one track by holding down the Ctrl
key when you click. When you click Extract, all selected tracks are extracted into a single new movie
file.

If you want to save a movie file you created by extracting a track, you probably should save it as a self-
contained movie (as described in the section Saving in Chapter 4); otherwise, it will still depend on the original
file.

Deleting tracks 

Sometimes you may want to simply remove one track from a movie. The process of deleting tracks is similar to
that for extracting tracks, but it removes the track from the movie file and doesn’t create a new file.
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To delete a track:

1. Chose Delete Tracks from the Edit menu.

A dialog box appears listing all of the tracks in the movie.

2. Select the track you want to delete and click Delete.

Your movie no longer contains the track you selected in step 2.

Tip: If a movie has multiple tracks, you can select more than one by holding down the Ctrl key when
you click. When you click Delete, all selected tracks are deleted.

Again, if you want to save a movie in which you have deleted tracks, you should save as a self-contained movie
(as described in the section Saving in Chapter 4). Otherwise, the file will still contain all of the deleted data and
will be much larger than it needs to be.

COMBINING TRACKS WITH THE ADD AND ADD SCALED COMMANDS

You can combine data from different movies, as well as add non-dynamic data, such as text and graphics, to
existing movies to create a new multiple-track movie.

When you paste data into a movie using the Paste command (as described in Chapter 4), you place data in
between the data that is already in the movie. If the slider is in the middle of the movie, the pasted data is placed
in between the data before and after the slider. (Even if it is audio data being pasted into a movie with video, the
audio is placed in between the pre-existing data, and a white frame appears while the new audio plays.)

If you want to place data in a movie so that it occurs at the same time as existing data, use the Add command
instead of the Paste command.

To add previously copied data so it plays concurrently with existing tracks:

1. Hold the Ctrl and Alt keys down and open the Edit menu.

Add appears in the menu instead of Paste.



Chapter 6 QuickTime 3 Pro: MoviePlayer for Windows 95/NT 4 Page 97

2. Choose Add.

The added data becomes a new track in the movie; this track is placed in parallel with the other tracks in the
movie. The added data lasts for the same amount of time it lasted in the original movie.

You can also add data that has no specified duration (non-dynamic data), such as text or graphics. In this case,
the added track is given a default duration, depending on the type of data.

It is possible to specify the duration of any type of added data, dynamic or not.

To alter the amount of time that added data appears:

1. Select a portion of the movie to which you’re adding data; your selection should have the start time and
duration that you’d like the added data to have.

2. Hold down the Shift, Ctrl, and Alt keys and open the Edit menu.

Add Scaled, rather than Add or Paste, now appears in the Edit menu.
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3. Choose Add Scaled.

The added track has a duration that matches the length of the selection you made in step 1. (If you made no
selection, the data is added for the duration of the track to which you are adding, as if you had selected the
entire track before adding.)

Since time-based data is squeezed or stretched to fit into the duration of the selection, you can use the Add
Scaled command to produce a fast- or slow-motion effect.

Tip: You can clear your selection without moving the slider by choosing Select None from the Edit
menu. This is particularly helpful when you are using the Add Scaled command to add several chunks of
data consecutively.

The following sections describe some typical uses of the Add and Add Scaled commands.

Adding new audio to a video movie 

A common use of the Add command is to add new audio to a movie.

To combine an existing audio track with other track types:

1. In MoviePlayer, open both the audio movie and the other movie. (The audio may have been previously
extracted from another movie. It can be a sound track or a music track.)

2. Select and copy the portion of the audio movie you wish to combine with the other movie. If you want to
select the entire movie, choose Select All from the Edit menu.
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3. Click in the other movie window and move the slider to the point in the movie where you’d like the audio to
start playing.

4. Hold down the Ctrl and Alt keys and open the Edit menu, then choose Add.

When you play the movie, the audio occurs at the same time as the preexisting tracks.

If an audio track is longer than the movie into which you are pasting it, the movie window is white for the
portion of the movie during which the audio extends beyond the available visual data. If this happens, you may
want to select the portion of the movie that contains only audio and choose Clear from the Edit menu.

Adding text 

In Chapter 5 we described how to create a text track by importing a text file. You can also add a text track to an
existing movie without first creating a separate text track. To do so, follow the steps described in the previous
section, using a text movie instead of an audio movie.

However, if you don’t have a lot of text to add, you can copy and paste text directly from a text editor or word
processor into the movie.

To add a single line of text to an existing movie:

1. Open a text editor or word processor.

2. Type the text you want to appear in the movie, then select and copy the text.

3. Click in the movie to which you want to add the text and move the slider to the place in the movie where you
want the text to appear.

4. Hold down the Ctrl and Alt keys and choose Add from the Edit menu.

A portion of the play bar is selected. You see a white bar along the bottom of the movie image; this is because
the slider is at the frame immediately following the frame containing the text you just pasted.
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Movie immediately after text has been added

If you move the slider to a location on the play bar before the selection and play the movie, the text is displayed
along the bottom of the movie image for two seconds starting at the point where the slider was located before
you added the text.
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Text track in a movie

If you select a portion of the movie and choose the Add Scaled command (hold down the Ctrl, Alt, and Shift
keys when you pull down the Edit menu), the text is added for the duration of the selection, rather than the
default two seconds.

The style, size, font, and color of the text you copy from most text editors and word processors is maintained
when you add the text to a movie.

We explain how to change the location of the text in the movie window later in this chapter, in the section
“Adjusting the size, location, and orientation of visual tracks.”

Adding still image graphics to a movie 

If you’ve already imported a still image as a QuickTime video track, you can copy and add it to another track.
(To add, hold down the Ctrl and Alt keys and choose Add from the Edit menu.)

You can also copy a still image from a graphics program and add it directly to a movie in the same way that you
copy text from a word processor and add it to a movie (as described in the previous section). You might do this
either to add graphics to an audio track, or to overlay some kind of logo or other relatively small image on a
standard video track.

Using the Add command to add a still image puts the image in for a default of one-fifteenth of a second. If you
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want to specify how long the image appears in your movie, use the Add Scaled command.

To add a graphic to a movie for a duration of your choosing:

1. Copy the graphic from your graphics program or a QuickTime video track.

2. Open the movie in which you want to place the graphic and select the portion of the movie during which you
want the graphic to be visible.

3. Hold down the Shift, Ctrl, and Alt keys and choose Add Scaled from the Edit menu.

Graphic pasted on a video track

The graphic is placed in the upper-left corner of the window by default. Later in this chapter, in the section
“Adjusting the size, location, and orientation of visual tracks”, we explain how you can adjust its location and
size.

Graphics are stored in an additional video track.

Text, music, and still image graphics are relatively small. You can combine just these data types using
the techniques described in this section to provide create a small, dynamic multimedia movie that down-
loads quickly over the Internet. You’ll find lots of information about putting a QuickTime movie on the
Web at the QuickTime Web site (http://www.apple.com/quicktime).

http://www.apple.com/quicktime/
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Adding new tracks to a QuickTime VR movie 

While MoviePlayer has limited capabilities for editing QuickTime VR movies, it is possible to add tracks to a
VR movie. Doing so requires changing the controller from a VR controller to a standard time-based controller.

To add text or graphics to a QuickTime VR movie:

1. Choose Get Info from the Movie menu, and in the right pop-up menu choose Controller. (Make sure Movie is
selected in the left pop-up menu.)

2. Select Movie Controller.

Movie Controller selected in the Controller panel of the movie info window

3. Use the Add Scaled command to add text or graphics to the movie, as described in the previous sections. (It’s
possible to add tracks with audio or dynamic video, but they don’t play when the controller is returned to the
VR controller, so there’s no reason to do this.)

• For object movies, the visual track added shows when the object is in the position which corresponds to
the frames in which you have added them, so you may want to add data to only selected portions of the
movie. If you add text, a user can use the Find command to quickly move the object to a specific
position. You might use a graphic or text to highlight something particular in an object when in a
specific position.

• For panoramic movies, any visual track you add for the entire duration of the movie appears in the
position in the movie window where you place it, no matter where you pan in the image.Therefore, you
should be sure to select the entire movie before adding data.

4. In the Controller panel of the movie info window, select the QTVR controller that was selected before you
selected the Movie Controller in step 2.

When you navigate in the VR movie, your added data appears.
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  A QuickTime VR object movie with a text track

ALTERING VISUAL TRACKS 

MoviePlayer’s info window, which you open by choosing Get Info from the Movie menu, provides access to a
number of different panels that allow you to alter visual tracks—video, sprite, 3D, MPEG, text, and timecode.

Adjusting the size, location, and orientation of visual tracks 

All visible tracks can be moved, resized, flipped, skewed, and rotated within the movie window. You’ll typically
want to do this when you’re compositing tracks.

To adjust the size, location, and orientation of a visible track:

1. In the movie info window, choose the track you want to alter from the left pop-up menu, and choose Size
from the right pop-up menu.

The Size panel appears.
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Size information for an individual track

2. Click Adjust.

In the movie window, the track appears with various red markings. The Adjust button changes to Done.

3. Click in the movie window and do any of the following:

Altering the image size of a track

• Drag any of the red corners towards the center of the image to shrink it, or away from the center of the
image to stretch it.
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• Press anywhere in the image (except on the red markings) and drag until the image is placed where
you’d like it.

• Press the circle in the center of the image and drag in any direction to rotate the image.

• Press one of the circles in the midpoint of any edge of the bounding rectangle of the image and drag to
skew the image. (Use a circle on either vertical edge and drag up or down to skew the image on its
vertical axis; use a circle on either horizontal edge and drag right or left to skew the image on its
horizontal axis.)

A rotated and skewed image

4. Click Done.

You can also quickly rotate or flip the image in a visible track by using the four buttons in the bottom of the
window.

To rotate a visible track 90 degrees clockwise or counterclockwise:

• Click the button with the looping arrow pointing clockwise to rotate 90 degrees clockwise.
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• Click the button with the looping arrow pointing counterclockwise to rotate 90 degrees
counterclockwise.

To flip a visible track:

• Click the button with the double-headed arrow pointing left and right to flip horizontally.

• Click the button with the double-headed arrow pointing up and down to flip vertically.

To return a track to its original size and orientation:

• Click the Normal button.

Changing layers 

When you add an extra visual track to a movie, it is placed in front of the existing tracks in the movie. You may
occasionally need to change this.

To change the layer of a track:

1. In the movie info window, choose one of the visual tracks you want to reposition from the left pop-up menu
and choose Layer from the right pop-up menu.

You’ll see that the track has a layer number. The first visual track in a movie has a default layer number of 0.
Each track added to the movie is placed in front of the existing tracks and assigned a layer number one less than
the lowest number already assigned. Thus, the lower the number, the farther to the front the track will be.

2. Click the upward or downward-pointing arrow as many times as is necessary to move the track to the layer
you wish. (You’ll want to be looking at the movie window to see when the layers are correct.)

• Pressing the downwards pointing arrow lowers the number of the layer and moves the track forward, so
that it is in front of any tracks that have a higher number.

• Pressing the upward-pointing arrow raises the number of the layer and moves the track behind any
tracks that have a lower number.
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Layer panel

Using graphics modes 

When you have more than one visual track, you may need to use the Graphics Modes panel to specify how a
track farther to the front appears.

1. In the movie info window, choose the video, text, sprite, or 3D track to which you’d like to alter the graphics
mode from the left pop-up menu, and choose Graphics Mode from the right pop-up menu.

2. In the list that appears, click any of the available choices.
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Graphics Mode panel

• For dither copy, copy, and composition (dither copy), the image is simply laid directly on the track below
it. There is no interaction between the track for which you are changing modes and tracks below it.
Dither copy is usually the default mode. Composition mode is appropriate for video tracks created from
some animated GIF files; when opened in MoviePlayer, the graphics mode automatically changes to
composition (dither copy) if needed. The difference between dither copy and copy is only apparent when
your system is in 256-color mode; dithering is the adjusting of adjacent pixels of different colors to give
the illusion of a color that’s not in the set of available 256 colors, so images look better. Copy mode
may, however, provide better performance in tight situations.

• Blend mode lets you make the video track translucent so you can partially see through to any track
below. The degree and color of the transparency can be set by using the Color Picker dialog box, which
appears when you click the Color button. The lighter the color selected in the Color Picker, the less
translucent the track will be; the darker the color, the more translucent it will be. If you choose 100%
lightness, you’ll get the same effect as the copy mode; if you choose 0% lightness the image will be so
completely transparent that it will be almost invisible.

• Transparent mode lets you define a particular color in any visual track to be transparent. Use the Color
Picker dialog box to specify the color that you want to be transparent. (To obtain the numeric values that
define a particular color, use a graphics program which has an eyedropper tool used in conjunction with
the Color Picker dialog box.)

• The next 4 modes all rely on alpha channels. An alpha channel defines what portions of the visible
image should be blocked out, or masked in order to show another image through the masked area.
(Alpha channels can be defined in programs like Adobe Photoshop or Adobe After Effects.) Premul
white alpha is tuned for images created on a white background with a premultiplied alpha channel.
Premul black alpha is tuned for images created on a black background with a premultiplied alpha
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channel. Straight alpha blend is a combination of straight alpha and blend, so the masked areas will be
transparent, and the non-transparent areas will be translucent. As with blend, you can use the color
picker to alter the degree of translucency.

Note: In order to have an alpha channel, an image must be in millions+ colors. If you convert an image
or animation into a QuickTime video track, you must ensure that it stays in millions+ colors. Currently,
the only codecs built into QuickTime that can work in millions+ colors are Animation, None, and Planar
RGB. Thus, when you create a video track—whether by importing a file into MoviePlayer, rendering
from an animation program, or outputting from an editing program— you must make sure to pick one of
these codecs if you want to take advantage of the file’s alpha channel. (Some still image files, when
opened in QuickTime, retain their millions+ colors; since these don’t get converted, there’s no need to
worry about the codec.) See the appendix for more information on compression.

Masking 

MoviePlayer allows you to superimpose a non-rectangular shape, or mask, on a visual track, so the image plays
within or outside of the shape. Masking works with QuickTime VR movies as well as standard time-based
movies.

To mask a visual track:

 1. Use a graphics editor to create a black graphic of the shape you’d like on a white background, and save or
export it in any of the still image formats that QuickTime supports (see the appendix for a complete list).

2. Open your QuickTime movie in MoviePlayer.

3. In the movie info window, choose Video Track from the left pop-up menu and Mask from the right pop-up
menu.

4. Click Set.

An Open dialog box appears.

5. Choose the file that you created in step 1.

The shape (stretched to fit the dimensions of the movie window) appears in the dialog box and the movie
window; the visual track’s image appears only in the area defined by the shape.
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Mask panel with masked movie

To invert the mask so the image plays outside the shape:

• Click the Invert button in the Mask panel of the movie info window.

Mask panel with inverted masked movie

To remove a mask:

• Click the Clear button in the Mask panel of the movie info window.
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Adjusting gamma in video tracks 

Gamma adjustment means altering the middle tones of an image, but not the black or white tones. It is similar to
adjusting the brightness and contrast of an image. Gamma adjustment is useful when switching movies from a
Mac OS computer to a Windows computer, or vice-versa.

MoviePlayer lets you adjust the gamma of video tracks that have been compressed with the Component Video
compressor.

To change the gamma of a video track compressed with the Component Video compressor:

1. In the movie info window, choose the video track from the left pop-up menu, and choose Gamma from the
right pop-up menu.

You see a slider with a thin green line showing the current gamma setting. The number next to “Current value”
shows the numerical value of the gamma setting.

Gamma panel

 2. Drag the thin green line left or right.

As you drag left the image gets lighter. As you drag right it gets darker. The numerical value also changes
accordingly. (If you’re going from the Mac OS to Windows, you should make the image lighter; if you’re going
from Windows to the Mac OS you should make the image darker. )

Changing 3D tracks 

MoviePlayer allows you to change a couple of properties of 3D tracks.

You can change the renderer that’s used to produce the surface of the 3D objects in the track.
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To change the renderer of a 3D track:

1. Choose Get Info from the Movie menu. In the movie info window, choose the 3D track from the left pop-up
menu, and choose Renderer from the right pop-up menu.

Renderer panel with renderers listed

2. Click to select one of the renderers listed.

• The default renderer is typically identical to the interactive renderer, which shows solid surfaces for the
3D objects.

• The wireframe renderer removes any textures from the model, leaving only the wireframe defining the
geometry of the object.

You may see additional choices for renderers if you have plug-in renderers for QuickDraw 3D, the 3D
technology that works with QuickTime.

For certain 3D objects, MoviePlayer lets you apply a visual track as a texture. The objects that work are those
which have a texture map defined (using a 3D application) before becoming a QuickTime track. In certain cases
a track may already be mapped onto an object; you can swap a track of your choosing for that track.

To change the image mapped onto a 3D object in a 3D track:

1. Using the Add Scaled command (described in the section “Combining Tracks With the Add and Add Scaled
Commands “ earlier in this chapter), add the track consisting of the visual data you want to map onto a 3D
object to the movie containing the object; scale it so it lasts for the duration of the 3D track. (Don’t worry if the
added track covers or overlaps other tracks.)
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2. In the movie info window, choose the 3D track from the left pop-up menu, and choose Texture Overrides
from the right pop-up menu.

Object listed in Texture Overrides panel

3. If an object is listed, click to select it. (If no object is listed, you can’t continue.)

4. Click the Select Texture Track button.

A Select Texture Track dialog box appears.

Select Texture Track dialog box

5. In the Select Texture Track dialog box, select the track you added in step 1 and click OK.
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When you play the movie, the new track is mapped onto the object.

6. If a track was previously defined as a texture, that track now plays separately in the movie window. Delete
this track. (See the section “Deleting tracks”, earlier in this chapter.)

Changing sprite tracks 

You can change a few properties of sprite tracks. You can assign a QuickTime track, such as a video track, to
individual sprites in a sprite track, in effect creating video sprites. You can also change the background color of
the sprite track.

To change the background color of a sprite track:

1.Choose Get Info from the Movie menu. In the movie info window, choose the sprite track from the left pop-up
menu, and choose Properties from the right pop-up menu.

The current background color appears in the bar below the words “Background Color”.
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Sprite properties panel

2. Click the Set button and, in the resulting dialog box, choose a new color and then click OK.

A sprite can be composed of both pixels and vectors (mathematically defined curves). The Media Scales
Dynamically checkbox is important for vector sprites. If this checkbox is not selected, the sprites will
look blocky when the movie window is resized; if it is selected, the sprites will look smooth at any size.

To assign another visual track to a sprite:

1. Using the Add Scaled command (described in the section “Combining Tracks With the Add and Add Scaled
Commands “ earlier in this chapter), add the track you want to assign to a sprite to the movie containing the
sprite; scale it so it lasts for the duration of the track.

2. In the movie info window, choose the the sprite track from the left pop-up menu, and choose Image Override
from the right pop-up menu.
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Sprites listed in the Image Overrides panel

3. Click in the numbered list to select the sprite to which you want to assign a new image. (The current image
for the sprite appears in the image area in the bottom of the window.)

4. Click the Select Override Track button.

A Select Override Track dialog box appears.

Select Override Track dialog box

5. Click the added track, then click OK.

When you play the movie, the sprite selected in step 3 consists of the track selected in step 5.
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Sprite track with sprite replaced with video track

Adding a custom color table to a movie 

QuickTime movies don’t look their best when they’re composed of millions or thousands of colors and the
computer they’re playing on shows only 256 colors. The 256 colors used may not be the right colors for any
particular movie. Standard system colors, for example, don’t have many flesh tones. Fortunately, you can
designate a custom color table for a movie so that when it plays, the computer on which it is playing switches to
a better set of 256 colors. A movie with a custom color table still doesn’t look as good as it would if more colors
were available, but it looks better than it would if using the standard system colors.

If you have an existing file with a custom color table, you can attach it to your movie. Files that may already
include a custom color table include graphics file (such as GIF) and other QuickTime movies. To define a
custom color table for your own movie, you need software that can analyze your movie and figure out which
256 colors to use. Debabelizer is a commercial product that can create a custom color table for a movie. It can
also analyze a group of movies and pick the 256 colors that will work best for the whole set.

To add a custom color table to a movie:

1. Choose Get Info from the Movie menu.

2. In the movie info window, choose Movie from the left pop-up menu, and choose Colors from the right pop-
up menu.

3. Click Set and locate the file that has the custom color table.
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Colors panel with custom color table

To remove a color table that has been assigned to a movie:

• Click Clear in the Colors panel of the movie info window.

ALTERING AUDIO TRACKS 

MoviePlayer lets you to do several things with audio tracks.

Adjusting volume and balance 

The Volume panel in the movie info window allows you to change the volume at which sound, MPEG, MPEG
Audio, and Music tracks play. You may want to do this if you have more than one audio track in a movie, and
want to adjust the volume of the tracks relative to each other.

The Volume panel also allows your to adjust the balance; if you have stereo speakers, you can direct the audio
from the left to the right speaker.

This panel is available for sound and music tracks.

To adjust volume and balance:

1. In the movie info window, choose the audio track for which you’d like to change volume or balance from the
left pop-up menu, and choose Volume from the right pop-up menu.
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Volume panel in movie info window

2. Make changes to volume and/or balance:

• To make the track louder, drag the bar in the top rectangle to the right or click to the right of the point to
which the bar currently extends. (If you drag to the right of center, the bar turns red to warn you that the
sound may become distorted.) To make the track quieter, drag the bar to the left or click to the left of the
bar’s current length.

• To direct more of the sound to the right speaker, click in right side of the lower rectangle (labeled Left,
Center, and Right). To direct more of the sound to the left speaker, click in the left side.

Tip: Holding down the Ctrl and Alt keys when you click in the Volume area makes the indicator bar snap
to numerical values that are increments of 25. Holding down the Ctrl and Alt keys when you click in the
balance rectangle makes the little green line snap to Left, mid-way between Left and Center, Center,
mid-way between Center and Right, and Right.

Changing instruments in music tracks 

With QuickTime music tracks, you can change the way the music sounds by changing the instruments used in
playing the musical parts in the piece of music.

To change an instrument used in a music track:

1. In the movie info window, choose the music track for which you’d like to change instruments from the left
pop-up menu, and choose Instruments from the right pop-up menu.
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A list appears in the window. The items in this list are the General MIDI instruments currently used in the music
track.

Instrument panel showing instruments used in a music track

2. Double-click any instrument in the list.

A dialog box appears, where you can make the following changes:

• Using the pop-up menu closest to the top, choose the synthesizer. In almost all cases you should leave
this set to Best Synthesizer, which causes QuickTime to choose the best synthesizer for playing back the
musical notes. Typically, the best synthesizer is the QuickTime Music Synthesizer; this uses the sound
samples stored in QuickTime. If you have an external synthesizer installed and properly configured in
the QuickTime Settings control panel , QuickTime may recognize this external synthesizer as the best
synthesizer; see the appendix for details. If you want to ensure that a specific synthesizer is used, choose
it in this pop-up menu.

• Using the Category pop-up menu, choose a family of instruments. The category you choose changes the
choices in the next pop-up menu, labeled Instrument.

• Using the Instrument pop-up menu, choose the instrument that will be played by the musical notes
stored in the movie file.
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Instrument selection dialog box

You can sample the instrument that is selected by clicking or dragging across the keyboard at the bottom
of the dialog box.

3. Click OK when you have finished making your choices.

CHANGING THE QUALITY OF TRACKS 

QuickTime has default settings that allow movie tracks to play back well under almost all circumstances. For
playback on fast computers, you can increase the visual or sound quality of some tracks by enabling high
quality.

To increase the quality of video, text, sprite, or sound tracks:

1. Choose Get Info from the Movie menu. In the movie info window, choose the track you’d like to change
from the left pop-up menu and choose High Quality from the right pop-up menu.
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High Quality panel

2. Click the High Quality Enabled checkbox to select it.

Enabling high quality affects tracks in the following ways:

• For video tracks, it improves the color representation and image smoothness when the movie window is
resized; an improvement will only be noticeable on low-color display screens.

• For text tracks, it enables anti-aliasing (smoothing of the edges of the text).

• For sprite tracks, high quality improves scaling so the sprites still look good when the movie window is
resized.

• For sound tracks which are 16-bit, when played back on computers that don’t have the ability to play 16-
bit audio, high quality makes the sound slightly cleaner.

• For other track types, it currently doesn’t do anything.

Enabling high quality decreases performance, so it is best to do so only if you are sure your movie will be
played on very fast computers.

PRELOADING TRACKS 

Normally QuickTime reads movie data off the disk on which it is stored, as it is needed. You can, however,
specify that the data from certain tracks be put into memory (RAM).

To specify that track data be put into memory:
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1. Choose Get Info from the Movie menu. In the movie info window, choose the track you’d like to have load
into memory from the left pop-up menu and choose Preload from the right pop-up menu.

2. Select Preload and/or “Cache hint”:

• If you select Preload, QuickTime tries to put the entire movie into memory before it is played. This
option is ideal for small amounts of data, such as in text and music tracks. It allows the movie to play
smoothly while the system is doing other things, such as loading another movie from a CD-ROM disc.

• If you select “Cache hint”, QuickTime keeps movie data in memory after it has played. This option is
useful for small files you wish to loop. If the movie is too large to remain in memory, however, it will
perform poorly.

Preload panel

Warning: You should use the Preload and “Cache hint” options only with tracks that contain very small
amounts of data; asking QuickTime to put too much data into memory can cause poor performance,
system errors, and unpredictable results.

DISABLING AND ENABLING TRACKS 

You can turn different tracks on or off. For example, you can switch between two different audio tracks by
disabling one or the other. You can also make text tracks invisible, yet still searchable. Unlike many other
editing actions, enabling and disabling tracks is a temporary action. A disabled track can always be enabled, and
vice versa.

Warning: Although disabled tracks have no impact on memory and playback performance when played
locally, they are downloaded when a movie is used on the Web, and so will affect streaming Web play-
back performance.
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To disable a track:

1. Choose Enable Tracks from the Edit menu.

The Enable Tracks dialog box appears with all tracks listed. To the left of each is an icon, labeled “On” or
“Off”.

Enable Tracks window

2. Click the track you want to disable.

The icon changes to “Off”.
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Text track turned off

3. Click OK.

In your movie, the track you selected in step 2 disappears, if it’s a visual track. If it’s an audio track, you don’t
hear that track when the movie is played.

The movie can be saved this way, and when subsequently opened, the track will continue to be disabled. The
track still exists and can be enabled later.

To enable a disabled track:

1. Choose Enable Tracks from the Edit menu.

2. Click the track you want to enable.

The icon to the left of the track name changes from “Off” to “On”, and the track reappears.

You can disable or enable any track in a QuickTime movie.

ALTERNATE TRACKS 

A QuickTime movie can have a set of tracks that are alternates for each other. The most common use of this
feature is to provide tracks in more than one language. For example, you may want to provide both an English
and a German version of a text track and/or a sound track. Anyone who opens the movie in MoviePlayer can
use the Choose Language command in the Movie menu to choose a language.
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Choose Movie Language dialog box

 In addition, movies with alternate tracks can be controlled using some multimedia authoring programs.

To designate a group of alternate tracks:

1. Choose Get Info from the Movie menu. In the movie info window, choose one of the tracks for which you
want to designate an alternate from the left pop-up menu, and choose Alternate from the the right pop-up menu.

Alternate panel of movie info window

2. Click the lower Set button (the one parallel to the words “Alternate”).

A dialog box appears in which all the tracks of the movie are listed:
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Set Track Alternate dialog box

3. Choose the track you wish to designate as an alternate and click OK.

Both tracks are in the alternate group; if you check the alternate for the track chosen as the alternate, you’ll see
that it has the other already chosen.

4. For each additional track you’d like to assign to the alternate group, follow the preceding steps and assign
one of the tracks already in the group as an alternate.

Note: You will see only one alternate listed in the info window, even if you have an alternate group
consisting of more than two tracks.

If you have assigned alternates for the purpose of having alternate languages, you’ll need to specify the
language for each track in the group.

To set the language for a track:

1. In the Alternate panel of the movie info window, click the top Set button.

A dialog box appears in which multiple languages are listed:
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Set Track Language dialog box

2. Click the name of the language that is appropriate for the track, then click OK.
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Appendix

This appendix contains information about QuickTime capabilities which are accessible to MoviePlayer as well
as other software applications.

• File Formats QuickTime Supports 

• Video 

• Audio 

• Still Image 

• Animation 

• MIDI 

• Text 

• Compression Choices for Video and Sound 

• Video compression dialog box 

• Video compressors included with QuickTime 

• Sound compression dialog box 

• Sound compressors included with QuickTime 

• Video Filters 

• QuickTime Settings Control Panel 

• Connection Speed 

• File Type Associations 

• Media Keys 

• Music 

• Registration 

• Sound In 

• Sound Out 

• Video Settings 

• Mouse and Keyboard Shortcuts and Enhancements 

• Movies on the Web 
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FILE FORMATS QUICKTIME SUPPORTS

The tables below show the file formats QuickTime 3 currently supports. Unless it is indicated that the file needs
be imported and saved, it can be opened like any QuickTime file. (See Chapter 5 for information on importing
files.) Formats in which QuickTime can export are also indicated.

Video

AVI Creates a video track and/or audio track.

DV Creates a video track and/or audio track. Can also export a video track in this format.

OpenDML Creates a video track and/or audio track.

Audio

AIFF/AIFC Creates a sound track. Can also export sound tracks and music tracks into this format.

DV Creates a sound track.

Sound Designer II Creates a sound track.

System 7 Sound Must be imported and saved. Creates a sound track. Can also export sound tracks into this
format.

uLaw (AU) Creates a sound track. Can also export sound tracks into this format.

WAV Creates a sound track. Can also export sound tracks into this format.

Still Image

3DMF Must be imported and saved. Creates a 3D track. (Without tween track doesn’t animate.)

BMP Creates a video track. Can also export in this format.

GIF Creates a video track.

JPEG/JFIF Creates a video track.

MacPaint Creates a video track.

Photoshop Creates a video track.

PICT Must be imported and saved. Creates a video track. Can also export in this format

PNG Creates a video track.

QuickTime Image Format Creates a video track.

SGI Creates a video track.

Targa Creates a video track.

TIFF Creates a video track.
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Animation

Animated GIF Creates a video track.

FLC/FLI Creates a video track.

PICS Must be imported and saved.Creates a video track.

MIDI

Karaoke MIDI Must be imported and saved. Creates a music track and a text track.

Standard MIDI General MIDI Needs to be imported and saved. Creates a music track. Can also export
music tracks in this format.

TEXT

Text Must be imported and saved. Can import text files with text descriptors and time stamps.
Creates a text track. Can also export text tracks as plain text or with text descriptors and
time stamps.

COMPRESSION CHOICES FOR VIDEO AND SOUND

QuickTime provides a set of standard dialog boxes for setting compression options, for both video and audio.
These dialog boxes may be used by any number of applications.

Video compression dialog box

The standard video compression dialog box is usually called the Compression Settings dialog box. In
MoviePlayer, you use this dialog box when importing some still image and animation formats, as well as when
exporting as a QuickTime movie or as a picture. (The bottom section of this dialog box, labeled Motion, is not
available when importing a single still image, or when exporting as a picture.)
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The Compression Settings dialog box

The features of this dialog box include:

Image sample: The upper-right corner of the window contains an image sample, which shows the effects of
some of the choices you make in the dialog box. You can zoom in on the image by clicking it while holding
down the Ctrl and Alt keys. To view different portions of a zoomed-in image, you can drag in the image to
move the image around. To zoom out, hold down the Shift and Ctrl and Alt keys while clicking the image.

Compressor: The top pop-up menu allows you to choose a compressor. QuickTime has a number of built-in
compressors. See the table below for a complete listing of compressors. In addition, you can install additional
software to provide access to additional compressors; if you do so, they will be listed in this menu as well. (Two
compressors not currently included with QuickTime, but which you can obtain yourself, are TrueMotion from
Duck and Escape from EIDOS.) Your choice of compressor should depend on the type of image and the in-
tended use for the movie. When you choose certain compressors, an Options button appears at the bottom of the
Compression Settings dialog box, allowing access to additional features of the compressor.

 A compressor may also be called a codec, which is short for compressor-decompressor.

Colors: The second pop-up menu lets you select the number of colors to use in your movie. This choice can
range from black and white to millions of colors; the specific choices available will depend on the compressor
you’ve chosen. For most compressors, your choices will be listed as numbers (256, Thousands, Millions, or
Millions+ colors). Some compressors have a choice that just says “Color”; the actual number of colors depends
on the particular compressor. (When the Video compressor is chosen, Color means thousands. When the Graph-
ics compressor is chosen, Color means 256 colors. For most other compressors it means millions of colors.) The
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image sample shows the effects of your color choice, assuming your computer system can show the color
choice you made.

Quality: The Quality section of the dialog box allows you to set the quality of the images in your movie using a
slider; the slider shows numerical values from 0 to 100 depending on its position. You’ll also see labels that say
Least, Low, Normal, High, and Most. The image quality and degree of compression are inversely proportional.
The higher you set the quality, the less compressed your movie will be. The lower the quality, the greater the
degree of compression. Not all compressors allow you to change the quality. You also see the effects of your
quality settings in the image sample in the upper-right corner of the dialog box.

Frames per second: In the Motion section of the dialog box, the value in the box labeled “frames per second”
sets the number of frames that will play every second. If you choose a number that’s lower than the movie’s
current frame rate, compression will cause frames to be deleted. If you choose a number that’s higher than the
movie’s current frame rate, the existing frames will simply be duplicated.

Key frames: For most compressors, when QuickTime compresses moving images, it does something called
frame differencing. This is the process of figuring out what information has changed from a starting frame
(called a key frame) to subsequent frames. The key frame contains all of the information for a particular image.
Subsequent frames contain the information that changed. In the Compression Settings dialog box, you can
specify how often you want key frames to occur. If you don’t have enough key frames, the quality of your
movie will be very low because most frames are generated from others. On the other hand, more key frames
means a movie that is larger and has a higher data rate. If you’re creating a movie that’s going to be played from
a slow medium, such as CD-ROM or over the Internet, you’ll want key frames less often, resulting in a smaller
movie with a lower data rate. It’s usually a good idea to set key frames to occur every second, or perhaps every
other second. So, for example, a 15-frame-per-second movie should have a key frame every 15 frames or every
30 frames. Also, with some compressors, if QuickTime senses during compression that enough of the image
data has changed, it will automatically insert a key frame.

Data rate: When you play a movie, a certain amount of data is available to be played every second. This
amount is called the data rate of the movie. It is usually measured in kilobytes or megabytes per second. The
data rate of a movie is affected by the other choices you can set in the Compression Settings dialog box. Since
some computer configurations can handle higher data rates than others, it is helpful to be able to explicitly set a
data rate; you can do so only for certain compressors (Cinepak, H.263, and Sorenson Video currently). For
example, if you want a movie to play from double-speed CD-ROM drives, you need to limit the data rate to a
maximum of about 250 K/sec.

You can check the data rate of a movie using the movie info window in MoviePlayer. (See “Getting
general information about the movie and its tracks” in Chapter 2.)
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Video compressors included with QuickTime

Compressor Comments

Animation Works best on computer-generated animations with broad areas of flat color. Doesn’t
work well when the scene has lots of color changes.

BMP Used for still images when exporting in the BMP format. Does minimal compression.
Inappropriate for video-based movie playback.

Cinepak Commonly used for video movies that require CD-ROM playback. Very slow
compressing.

Component Video A high-quality compressor. Good for capture on AV Macs and as intermediate storage
format. Low compression ratios. Larger files. Not good as a delivery format.

DV - NTSC & PAL Used with Digital Video cameras.

Graphics Good for 8-bit graphics files. Usually better than the Animation compressor in 8-bits.
Slower to decompress than Animation.

H.263 Designed originally for video conferencing. Very high compression ratios. Only works at
window sizes of 352x288 (CIF), 176x144 (QCIF), or 128x96 (sub-QCIF). (Movie
windows will be resized to one of these sizes.) Very high image quality. Requires a
Pentium for compression and decompression. No Mac OS version.

Motion JPEG A & B Used to decompress files made with certain hardware Motion-JPEG cards when the card
isn’t available, or to compress in a format that can be played by certain hardware Motion-
JPEG cards.

None Good for capture only. Does almost no compression.Large files.

Photo JPEG Ideal for high-quality compressed still images. Also useful as intermediate storage format
for movies and for QuickTime VR panoramas. Too slow decompressing to use for video-
based movie playback.

Planar RGB For importing photographic graphics with an alpha channel (for use when you have an
image that you want to composite with video).

Sorenson Video Very high compression ratios and high quality. Good for Web and CD-ROM. Very slow
compressing. On Mac OS computers, requires a PowerPC processor for compression.

Video Very fast compressing and decompressing of video. Decent compression ratios. Good for
realtime capture of video, particularly when hard disk space is at a premium. Good for
testing clips. OK on hard disk playback. Image quality is poor when compressing enough
for CD-ROM playback.
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Sound compression dialog box

The Sound Settings dialog box is also frequently available in various applications that use QuickTime. You can
access it in MoviePlayer when you export a QuickTime sound track to another sound format, as well as when
you export a movie with a sound track as a QuickTime movie.

Sound Settings dialog

Your options in the Sound Settings dialog box include:

Compressor: Depending on the sound format chosen, you’ll have different choices for compressor. See the
next section for information on the specific audio compressors available. When you choose certain compressors,
an Options button at the bottom of the dialog box becomes available, allowing access to additional features of
the compressor.

Rate: When sound is digitized, it is actually composed of a sequence of individual sound samples. The more
sound samples per second, the higher the quality of the resulting sound. In general, rates of 22kHz or 11kHz
(22,050 samples per second or 11,025 samples per second) usually result in very good quality sound.

Size: A sound sample can have a range of possible values. If there are many possible values, the sound will be
more accurately represented; if there are few possible values, the sound may not be exactly as it’s supposed to
be, because the correct value must be replaced by an available value. 8-bit sound provides for 256 possible
values, whereas 16-bit sound provides for 65536 possible values.

Use: You are given a choice of Mono or Stereo. Mono is the usual choice; most audio files you work with will
be recorded in Mono, anyway. On the rare occasion that you have a stereo file, and you want to retain its qual-
ity, it may make sense to select Stereo.
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Options button: This button is only available for certain compressors. Clicking it opens an additional dialog
box, in which you choose settings unique to the compressor.

Settings dialog box for QUALCOMM PureVoice compressor
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Sound compressors included with QuickTime

COMPRESSOR COMMENTS

24-bit &32-bit Integer Increases the sample size to 24 or 32 bits. (Though will be converted to 8 or 16 bits to
play on current hardware.)

32-bit &64-bit Floating Point Actually increases the sample size of the audio (to 32 or 64 bits) which allows for
more accurate conversion to other sample sizes, and the application of effects.

ALaw 2:1 Internet standard for compressed audio in Europe and everywhere else except the United
States and Japan. Low compression ratio and low quality. Generally not recommended.

IMA 4:1 Very good for music and other audio content. Must be 16-bit ; relatively low compression
ratio.

MACE 3:1 &  6:1 Out-dated Macintosh compressors. Low quality. Not generally recommended.

QDesign Music Codec Excellent for music content. Extremely low compression ratio.

PureVoice Excellent for voice content. Extremely low compression ratio.

uLaw 2:1 Internet standard for compressed audio in the United States and Japan. Low compression
ratio and low quality. Generally not recommended.

VIDEO FILTERS

QuickTime 3 has a small set of built-in filters for adding special effects to your video tracks. In MoviePlayer,
you can access these when you click the Options button when exporting a clip as a QuickTime movie.

FILTER COMMENTS

None Lets you undo any of the other filters in this table.

Alpha Gain Lets you manipulate the alpha channel of an image.

Blur Blurs the image. You can adjust the amount of blur and the brightness.

Color Style Lets you add solarization and posterization effects.

Color Tint Lets you change the image to black and white, tint it any color, and invert colors.

Edge Detection Finds the edges in the image. You can set the width of the edge and you can also choose
to colorize the results.

Emboss Gives the image a raised look by doing an offset. You can choose the amount of
embossing.

Film Noise Adds noise to the image so it looks like movie film. You can set various parameters,
including the Hair Density and Length, the Scratch Density, the Dust Density, and the
Dust Size from 0 to 25. You can also set the look of the film by making a choice from the
File Fade pop-up menu.

General Convolution Lets you enter values in a grid to specify a pattern of brightness of for the pixels in the
image. It’s based on a complicated mathematical process called convolution.

HSL Balance Lets you alter the look of the image by setting its hue, saturation and lightness.

RGB Balance Lets you alter the look of the image by setting its red, green or blue values.

Sharpen Sharpens the image. You can set the degree of sharpening and brightness.
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QUICKTIME SETTINGS CONTROL PANEL

The QuickTime Settings control panel has a number of panels: Connection Speed, File Type Associations,
Media Keys, Music, Registration, Sound In, Sound Out, and Video Settings. You can switch between panels
using the pop-up menu at the top of the window.

Connection Speed

This panel lets you indicate the speed of your Internet connection (modem, T1, etc.). If you download a Web
page that contains a link to a movie with different data rate files for different connection speeds, the setting here
tells your QuickTime browser plug-in which file to download.
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File Type Associations

You use the File Type Associations panel to indicate whether or not Windows, Macintosh, and/or Internet file
types should open in the QuickTime applications, MoviePlayer or PictureViewer. For example, if you check
“Windows files types”, when you open an AVI file, it will automatically open in MoviePlayer.



Appendix QuickTime 3 Pro: MoviePlayer for Windows 95/NT 4 Page 141

Media Keys

It’s possible to have a compressor that encrypts parts of a track; in order to play the track, you’ll need to have an
access key, which you would enter in this panel. (Currently used to control password protection in files com-
pressed with Sorenson Video or Indeo Video Interactive. )
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Music

The Music options are primarily of interest to those who have a hardware MIDI synthesizer. Without a hardware
synthesizer, you’ll have only QuickTime Music Synthesizer in the list of synthesizers; this is the built-in soft-
ware synthesizer that’s part of QuickTime.

If you do have a MIDI synthesizer with appropriate MIDI system software, you’ll need to add it to the list so
QuickTime knows about it and so you can select it. To do this, click the Edit List button, then use the Add and
Remove buttons in the resulting dialog box to alter the list. If you want an added synthesizer to be used as the
“Best Synthesizer” (as described in Chapter 6), click the radio button to the left of the synthesizer name in the
list to select it as the default synthesizer. (The default synthesizer will be used as long as it is capable of playing
the requested instrument; if another synthesizer in the list can better handle the request, it will be used instead.)
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Registration

Use this panel to register your copy of QuickTime. Registering QuickTime gives you access to all the features
of MoviePlayer and PictureViewer. It also lets you save QuickTime movies that are on the Web. If you already
have your registration information, click the Enter Registration button, then enter the information in the dialog
box that appears. If you don’t already have a registration number, click the “Register On-line” button; your Web
browser will open and a page with registration instructions will appear.
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Sound In

Use this panel when you’re capturing QuickTime movies. The setting here tells QuickTime what device to
“listen” to for the incoming audio. Since you can’t use MoviePlayer for capturing, you won’t need to use this
panel when using MoviePlayer.



Appendix QuickTime 3 Pro: MoviePlayer for Windows 95/NT 4 Page 145

Sound Out

This panel allows you to choose which device in your computer should be used for playing the sound in
QuickTime movies. If your system is DirectSound compatible, you will get better performance by choosing
DirectSound rather than waveOut.

This panel also allows you to choose settings for the format of the sound (Rate, Size and Use); these should be
set at 44.100 kHz, 16 bit, and Stereo, unless you are aware of compatibility problems.

The Options button allows you to change additional settings particular to the playback device. Most of the time,
you should leave the default settings here.
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Video Settings

The settings here determine how QuickTime works with your video display system.

If you select Safe Mode, QuickTime will only use Windows’ most fundamental method of drawing graphics on
the screen. This method is compatible with just about all Windows display systems, but is also the oldest and
slowest method and will not provide the best playback performance.

If you select Options, QuickTime will try to use any of the more advanced methods (DCI, Direct Draw, Direct
Draw Acceleration) selected. These will provide better playback performance. You should only deselect these if
you believe they are not compatible with your system.

Note: For best playback performance, you will need the current DirectDraw video driver. The Read Me
in the QuickTime folder provides information about where to get this driver.
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MOUSE AND KEYBOARD SHORTCUTS AND ENHANCEMENTS

The following table lists various mouse and keyboard combinations which work in MoviePlayer; many also
work in other Quicktime-aware applications.

Alt + Step buttons
Ctrl + Alt + right Step button
Ctrl + Alt + left Step button
Ctrl + Alt + drag size box
Shift + drag size box
Ctrl + Alt + Volume Control button
Up or Down Arrow keys
Left or Right Arrow keys
Enter or Space bar
Double-click movie image
Single-click playing movie image
Shift + double-click movie image
Shift + Volume Control button
Shift + pointer over image in VR movie
Ctrl + pointer over image in VR movie
Ctrl + Alt + pull down Edit menu
Shift + Ctrl + Alt + pull down Edit menu
Alt + Paste text copied from editor
Ctrl + Alt + click Image Sample in Compression dialog
Shift + Ctrl + Alt + click Image Sample

Show scratching slider
Jump to end of movie
Jump to beginning of movie
Scale to next “good” size
Scale movie disproportionately
Turn audio on/off
Raise or lower volume
Step back or advance one frame
Play if paused; pause if playing
Play
Stop play
Play the movie backward
Overdrive audio
Zoom in
Zoom out
Trim replaces Clear, Add replaces Paste
Add Scaled replaces Paste
Open Text Import Settings dialog box
Zoom in
Zoom out
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MOVIES ON THE WEB

When a movie is viewed within a Web browser, an additional button that looks like a downward-pointing
triangle appears to the right of the Step buttons. This is the Plug-In Commands button.

The movie controller as it appears in a Web browser

When you press the Plug-In Commands button, a pop-up menu appears with choices for how to save the movie,
as well as how to configure the QuickTime Plugin.

Pop-up menu that appears when the Plug-In Commands button is held down


